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Chapter 1. Reports overview

There are four main types of IBM® Sterling Control Center reports:
v Standard Sterling Control Center reports are produced from the Sterling Control

Center console, either on demand (Tools > Reports > Define/Run) or by
scheduling them to be run at a certain time and sent to designated recipients
through email (Tools > Reports > Automate). You can run existing reports using
the Web Console.
The Audit Log is a standard report of changes made to IBM Sterling
Connect:Direct® server configuration objects. It can be run as an on-demand
report or displayed on screen (by selecting Tools > Audit Log).

v Database reports use SQL queries or a third-party tool such as Crystal Reports to
extract data from the Sterling Control Center databases and create the reports.
Sterling Control Center provides several sample reports in Crystal Reports
format that you can use with the Sterling Control Center databases if you
already have Crystal Reports. You can also use these samples as templates to
design your own reports. For more information on database schemas, including
database tables and field definitions, see Data for Third-Party Reporting Tools.

v Log files on standard reports are saved to the Cognos/logs folder. After using
these logs for general debugging and maintenance purposes, you may want to
clear out these backups on a regular basis to keep this directory to a reasonable
size.

v The SLC Debug Report is useful for troubleshooting an SLC. This report
includes the SLC definition, definition of all schedules referenced by the SLC,
related SLC events produced for the SLC, definition of rules triggered by the
SLC events generated, definition of actions taken by triggered rules, and the
email system settings for the engine. This report is initiated from the Sterling
Control Center Console (by selecting Tools > Run SLC Debug Report). The
report is saved to the Sterling Control Center engine log folder and the name of
the file is SLCDebugReport.html.

Important: When you add an IBM Sterling Connect:Direct node to Sterling Control
Center for monitoring, you must run configuration management on the node
before you can run reports on it. To manage a configuration option, such as,
functional authorities, Sterling Control Center polls the node and puts the
information in the database. After the database is populated with the information,
you can run reports on the node.

Table of buttons
You may see the following buttons when using report functionality in Sterling
Control Center. Clicking the button allows you to perform the action listed in the
Description column of the following table:

Button Name Description

Create button Opens the Create Report
dialog.
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Button Name Description

Right Arrow button Allows you to select an
existing report, schedule, or
email list when automating a
standard report. When
creating a report, allows you
to select columns for sorting
purposes.

Left Arrow button Allows you to deselect an
existing report, schedule, or
email list when automating a
standard report. When
creating a report, allows you
to deselect columns for
sorting purposes.

Down Arrow button Sorts the data in the selected
column in descending order.

Up Arrow button Sorts the data in the selected
column in ascending order.

Run Report button Starts the process of running
a report and opens the IBM
Cognos® Viewer.

Remove button Deletes a saved report.

Duplicate button Allows you to duplicate an
existing report, schedule, or
email list when automating a
standard report. On the
Report Listing window,
allows you to duplicate the
highlighted report and opens
the Customize Report dialog.

Keep this version drop-down
list

In the IBM Cognos Viewer,
allows you to select the
Email Report option to send
the report output.
Note: Make sure you already
have the desired export
format selected before you
select this option.

View in HTML drop-down
list

In the IBM Cognos Viewer,
allows you to select one of
the following export formats
for your report output:

v PDF

v Excel (Excel 2007, Excel
2002, CSV)

v HTML

v XML

Note: Because of the save
and print functionality built
into their applications, PDF
and Excel are easy formats to
use.
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Button Name Description

Filter button Allows you to filter the
contents of the current
window using Key, Operator,
and Value criteria. The filter
criteria displays in the
window title bar.

Clear Filter button Clears the filter criteria and
the contents of the current
window are displayed as
originally shown. The filter
criteria is shown as NONE in
the window title bar.

Export list to PDF button Allows you to export the
contents of the current
window to a PDF file.

Help button Opens the IBM Sterling
Control Center
Documentation Launch Page.

Properties button Opens the Report Properties
window for the report
selected on the Report
Listing window.
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Chapter 2. Standard reports overview

Sterling Control Center includes a number of standard reports which you can
create on demand or using automation.

Standard reports are grouped into the following categories or reports types:

Report Category Report Name

QuickFile QuickFile File Transfer Report
QuickFile Users Detail Report

MQ MFT MQ MFT File Transfer Report

Configuration Management Functional Authorities Report
Sterling Connect:Direct Secure Plus Cipher Suites Report
Initialization Parameters Report
Sterling Connect:Direct Secure Plus Key Certificates Report
Netmap Communication Paths Report
Sterling Connect:Direct Secure Plus Nodes Report
Netmap Modes Report
Sterling Connect:Direct Secure Plus Trusted Certifications
Report
Netmap Nodes Report
User Proxies Report
Versions Report

Monitoring Sterling Connect:Enterprise® Statistics Log Report
Sterling File Gateway Route Detail by Producer
Sterling Connect:Direct Process Statistics Summary
Sterling File Gateway Route Detail by Consumer
Sterling Connect:Direct Statistics Log Report
Sterling B2B Integrator Business Process Details
Sterling Connect:Enterprise Batch Statistics Details
Sterling B2B Integrator Business Process Summary
Sterling Connect:Enterprise Batch Statistics Summary
Sterling B2B Integrator File Transfer Report
High Watermark Report
Sterling Connect:Enterprise Statistics Log Report
FTP File Transfer Report
Sterling Connect:Direct File Agent Process Submission
Report
Sterling Connect:Express Process Statistics Summary
Sterling Connect:Express Process Statistics Details

Node Discovery Potentially Inactive Netmap Entries Report
Netmap Connections Summary Report
Potentially Missing Netmap Entries Report
Node Discovery Topology Report

System Alerts Report
Server Inventory ReportAudit Log Report
Server Status Report
Sterling Control Center License Report
Service Level Criteria Summary Report
Database Events Report
Users-Roles Summary Report
Monthly File Transfer Activity Report
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Creating standard reports
When you create a standard report, you can save it to rerun later. You can also
export the report output to a variety of formats, and email and print it as well.

Before you begin

This procedure assumes you have Adobe Reader installed and focuses on that
export format. You can also easily select an Excel format (Excel 2007 Format, Excel
2002 Format, CSV Format) and use the print and save functionality in that
application as well.

About this task

This procedure covers the following functions:
v Creating a report by defining the data it will contain and how data in the

columns will be sorted
v Changing the sorting priority in a report
v Exporting the report output to a variety of formats
v Printing a report
v Saving report output
v Emailing report output
v Saving a report format to run later

Procedure
1. Select Tools > Reports > Define/Run to display the Report Listing window.
2. Click the Create button to open the Create Report dialog.
3. On the Report Type wizard panel, select the Report Category and Report

Type you want to create, and click Next.
For Configuration Management reports to include non-current versions of
configuration objects in reporting, check Allow celection of non-current
versions. If you do not click this option, only current versions of configuration
objects are included.

4. To limit a report to certain criteria, specify those criteria on the Filter wizard
panel, and click Next. (Not all reports allow you to specify criteria to narrow
the report or to specify parameters.) For more information, see About report
criteria and Defining report criteria.

Note: Specifying the same Key value more than once is treated as an AND
condition. Example: To narrow an Alerts report to a date/time range, specify
report criteria similar to the following: Alert Date/Time - Greater Than - Sept
30, 2010 00:00:00 America/Chicago Alert Date/Time - Less Than -Today
00:00:00 America/Chicago.

5. In the Available Columns section of the Sort wizard panel, highlight the
columns whose data want to sort and click the Right Arrow button.
Depending on your reporting needs, take any of the following actions:
v In the Selected Columns section, change the priority sorting order by

selecting the column name and clicking Move Up or Move Down.
v The default sort order for each column is ascending. To sort the data in a

column in descending order, highlight the column name and click the
Down Arrow button for the Sort Direction.
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Note: Certain reports, such as the Sterling Connect:Enterprise Statistics Log
Report, contain so much data that an additional Columns wizard panel opens
for you to select the data you want in the report output before the Sort wizard
panel is displayed.

6. When you are finished selecting options on the Sort wizard panel, click Next.
7. On the Confirm Choices wizard panel, click the Run Report button to generate

the report. The report is displayed in the IBM Cognos Viewer, which is a
separate browser.

8. To select the export format for the report output, click the View in HTML
Format drop-down list and select View in PDF Format.

9. To print and save the report output, use the print and save functions in Adobe
Reader.
CAUTION:
Do not use the print command in your Web browser to print reports.

10. To email report output, make sure the export format is set to the appropriate
file type, and then click the Keep this version drop-down list. Select the
Email Report option.
CAUTION:
Do not change the default email options. Keep only the Attach the report
option selected.
A separate pop-up window opens for you to enter one or more email
addresses and other optional information.

11. When you are finished entering email options, click OK. The pop-up window
closes and the report is attached to the email being sent.

12. When you are finished using the IBM Cognos Viewer, click the browser close
button to close the report output window.

13. To save the report with the criteria you selected, type a Report Name and
optional Description on the Save Report wizard panel and click Save. The
report is saved and displayed in the Existing Reports section where all
reports are listed in alphabetical order.

14. Click the close button to close the Create Report dialog.

About report criteria
When you create or modify a report, the output may be limited by one or more
filter criteria.

At least one criterion is required. The available criteria depend on the report type
selected. For many reports, the list of filter criteria is equivalent to the report's
available columns. See individual report descriptions for details.

When filtering on Server or Server Group, you select from a list of managed
servers/groups. For Date and Time you select Relative to identify a date/time
relative to report generation time, or Absolute to select a specific date and time.

Wildcard characters can be used in the selection criteria for some reports and are
as follows:
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Wildcard Character Meaning

* Represents one or more characters.

Example 1: ‘C*' represents any value that begins with the letter C.

Example 2: ‘abc*abc*abc’ could match on a variety of strings, such
as abc1abc2abc, abc1111abcabc, or abcfabcstrabc.

? The individual character in this exact position can be any character.

Defining report criteria
You can limit report output based on one or more criteria.

About this task

To define report criteria:

Procedure
1. From the Report Listing window, double-click the report to modify or click the

Create button to create a new report.
2. Do one of the following:

v If you are modifying an existing report, click the Filter tab and select the
criteria used to limit the report output in the Key field.

v If you are creating a new report, follow the prompts. When prompted for
Filter, select a filter criterion to use in the Key field.

3. Select the Operator to use to further define the criteria. Choices of operator
depend on type of data. For example, numeric-based keys typically take an
operator of “equal to,” 'not equal to,” “greater than,” or “less than,” while
character-based keys take operators of “matches,” “doesn't match,” and
“contains.”

Note: Some reports also allow wildcard characters in the selection criteria.
4. Click the cell in the Value column and select an argument to finish defining the

filter criterion.
5. Repeat the previous steps to define multiple selection criteria. Multiple criteria

must all be true for a record to be selected (they result in a logical AND
condition).

6. Do one of the following:
v If you are modifying an existing report, click Update.
v If you are creating a new report, follow the prompts to complete the report.

For more information, see Creating standard reports.

Customizing a report
Once you create and save a report definition, you can run it any time. A report
definition identifies the criteria used to create the report output. Use the customize
option to modify a report definition.

About this task

To customize a report:
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Procedure
1. Select Tools > Reports > Define/Run.
2. Highlight the report you want to customize and click the Duplicate button. The

Customize Report window opens.
3. Make changes as necessary to the existing filter and sort criteria and click

Update.
4. On the Confirm Choices wizard panel, click the Run Report button to generate

the report. The report is displayed in the IBM Cognos Viewer, which is a
separate browser.

5. For more information about printing, emailing and exporting the report output,
see Creating standard reports.
When you are finished using the IBM Cognos Viewer, click the browser close
button to close the report output window.

6. To save the report with the criteria you selected, type a Report Name and
optional Description on the Save Report wizard panel and click Save. The
report is saved and displayed in the Existing Reports section where all reports
are listed in alphabetical order.

7. Click the close button to close the Create Report dialog.

Generating your own reports
From Sterling Control Center, you can access IBM Cognos Connection to generate
and save reports and to run saved reports.

About this task

Unrestricted users with Manage Report permission can go directly into Cognos
Connection from the Sterling Control Center console. From Cognos Connection,
you can access Report Studio to generate your own reports and save them. You
can also run a saved report. To access IBM Cognos Connection:

Procedure

From the Sterling Control Center console, click Tools > IBM Cognos Reports. For
more information on using Cognos Connection, see the IBM Cognos Business
Intelligence 10.1.1 Information Center.

Viewing or modifying report output
You can view or modify report output.

About this task

For more information, seeCreating standard reports.

To view or change report output:

Procedure
1. Select Tools > Reports > Define/Run.
2. Double-click the report to view or modify. The Run Report windows is

displayed.
3. Modify fields on the Filter and Sort tabs as necessary. For more information,

see About report criteria and Defining report criteria.
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4. Click Update.

Running reports on demand
You can run an existing report on demand.

About this task

If you do not have a report defined yet, see Creating standard reports for more
information. To run a report that has been saved:

Procedure
1. From the Sterling Control Center menu, select Tools > Reports > Define/Run

to display the Report Listing window.
2. Select the report you want to run and click the Run Report button. The report

is displayed in the IBM Cognos Viewer, which is a separate browser.
3. To select the export format for the report output, click the View in HTML

Format drop-down list and select View in PDF Format.
4. To print and save the report output, use the print and save functions in Adobe

Reader.
CAUTION:
Do not use the print command in your Web browser to print reports.

5. When you are finished using the IBM Cognos Viewer, click the browser close
button to close the report output window.

Printing a report
You can print a report using the built-in print function in Adobe Reader or Excel.

About this task

To print a report:

Procedure
1. Select Tools > Reports > Define/Run.
2. On the Report Listing window, highlight the report you want to print, and click

the Run Report button to generate the report. The report is displayed in the
IBM Cognos Viewer, which is a separate browser.

3. To select the export format for the report output, select one of the following
options from the View in HTML Format drop-down list:
v View in PDF Format

v View in Excel Options and then select the desired Excel format (Excel 2007,
Excel 2002, CSV)

4. To print the output, use the print function in Adobe Reader or Excel.
CAUTION:
Do not use the print command in your Web browser to print reports.

5. When you are finished using the IBM Cognos Viewer, click the browser close
button to close the report output window.

Removing a saved report
You can delete an existing report.
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About this task

To remove a saved report:

Procedure
1. Select Tools > Reports > Define/Run.
2. On the Report Listing window, highlight the report you want to remove and

click the Remove button.
3. Click OK to remove the report. The report is removed from the Report Listing

window
4. Click the browser close icon to close the Report Listing window.

Note: You cannot delete a report that is referenced by an automated report.

Automating reports
You can automate standard Sterling Control Center reports to run according to a
defined schedule and to be sent to a list of email recipients.

About this task

Note: For UNIX systems, you must have an X11 graphics package on the UNIX
host where the Sterling Control Center engine is installed and a video card for
graphics.

A Filter function is available throughout this wizard to facilitate selecting items.
For example, if you have a long list of reports and want to see those that start with
Net, start typing the characters and only matching reports appear in the list.

To automate a report:

Procedure
1. Click Tools > Reports > Automate. The Automated Report listing displays.
2. Click the Create button. The Add Automated Report wizard displays.
3. Supply a Name and Description for the automated report. Make sure the

Enabled option is selected. Name is required.
4. To schedule an existing report, highlight the report in Reports and click the

Right Arrow button to move it to Selected Reports. You can also take one of
the following actions if the report you want to automate does not exist:
v To create a new report to schedule, click the Create button. See Creating

standard reports.
v To create a new report to schedule using an existing report as a starting

point, select the report and click the Duplicate button and modify the
report as needed.

5. Click Next. The wizard proceeds to Report Schedules.
6. To select an existing schedule, select a Report Schedule and click the Right

Arrow button to move it to Selected Report Schedules. Click Next. You can
also take one of the following actions if the schedule you want to use does not
exist:
v To create a new schedule, click the Create button. For more information, see

Schedule field descriptions in System Administration.
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v To create a new schedule using an existing schedule as a starting point,
select the schedule, click the Duplicate button, and modify the schedule as
needed.

7. Click Next. The wizard proceeds to Email Lists.
8. To select a list of email recipients, highlight the list in Email Lists and click the

Right Arrow button to move it to Selected Email Lists. You can also take one
of the following actions if the email list you want to use does not exist:
v To create a new email list, click the Create button. See Creating email lists for

automated reports.
v To create a new email list using an existing one as a starting point, select

the email list and click the Duplicate button and modify the email list as
needed.

9. Click Next. The wizard proceeds to Parameters.
10. Select a Report Format (PDF, CSV, XML, HTML) and report Attachment

Extension. You can modify the file extension to circumvent email attachment
restrictions. Add a From email address and a Subject line and click Next.

11. Click Next. The wizard proceeds to Summary.
12. Review your entries and click Finish to create the automated report. The

newly created report is displayed in the Automated Reports list.

Automated reports field definitions
Sterling Control Center provides automated reports field definitions.

Following are descriptions of automated reports fields.

Field Description

Name Automated report name.

Description A description of the automated report.

Report Schedule The schedule attached to the automated report. The schedule
determines when the automated report is generated and sent.

(List of recipients) The name of the list or lists of email recipients for the automated
report.

Report Format Format of the automated report. Options are comma-separated (CSV),
portable document format (PDF), or Excel spreadsheet (XLS).

Attachment
Extension

The file type or extension of the report file. You can specify no file type
or an alternative type which can later be changed by the recipient to
circumvent firewall restrictions.

From The “from” address to be specified in the email.

Subject The subject line of the email.

Creating email lists for automated reports
Automated reports are generated and sent via email to individual email addresses
or lists of addressees. You can create and maintain these lists of email addressees.

About this task

Because you can specify more than one email list for an automated report, you can
maintain a list specifically for a given report or construct the list from multiple
email lists.
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To create an email list:

Procedure
1. Click Manage > Email Lists and click the Create button. The Add Email List

dialog is displayed.
2. Add a Name and Description for the new email list and click Next. The Email

wizard panel is displayed.
3. To add email addresses to whom you want to send one or more generated

reports, type the email addresses separating the addresses with commas. You
can also take one of the following actions:
v To sort the email addresses in the To: field., click the S... button. The arrow

next to the button indicates whether the addresses will be sorted in
ascending or descending order.

v To import email addresses from a text file, click Import. A separate pop-up
window is displayed to allow you to browse and locate the existing file.
Select the file and click Import. The email address information is displayed
in the To: field.

v To export the list of email addresses displayed in the To: field, click Export.
A separate pop-up window is displayed. Type a filename and click Export.
The pop-up window closes.

4. Click Next. The wizard proceeds to Permissions which displays the existing
Restricted Roles.

5. You can take one of the following actions on the Permissions wizard panel to
identify who can view and use the email list:
v To allow all users to view and use the email list, select the This Email List is

visible to all users option.

Note: If you make the email list visible to all users, you cannot restrict
visibility to specific roles after it is created.

v To not let any users view and use the email list, select the This Email List is
visible to restricted users in these Selected Restricted Roles option.

v To give a restricted role permission to view and use the email list, highlight
the role and click the Right Arrow button to move it to Selected Restricted
Roles and make sure the This Email List is visible to restricted users in
these Selected Restricted Roles option is selected.

6. Click Next. The wizard proceeds to Summary.
7. Review your entries and click Finish to create the email list. The Finish wizard

panel is displayed.
8. Click Close to exit the wizard. The newly created email is displayed in the

Email List window.

Automated reports frequently asked questions
Following are solutions to issues that might arise with automated reports.

What could cause an automated report not to be delivered?

If an automated report fails to be delivered as expected, check for these conditions:
v The email server could be down. Make sure it is up.
v The output attachment size could exceed the limit allowed by the email server.
v Email servers may strip attachments with certain extensions. To prevent this

from happening, double-click the report in the Automated Reports listing, click
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the Parameters tab, and change the Attachment Extension. Inform recipients to
change the file’s extension back after receiving it via email to reflect the report’s
format.

v Email settings may not have been set up. Check on the Email tab of System
Settings (on the Manage menu).

v Make sure that the report schedule is correct.

If you are still having problems, look in the engine log file for errors.

Are there best practices to follow for automated reports?

It is a good idea to schedule automated reports to run when less activity is
occurring on managed servers. This reduces the impact of report generation on
normal monitoring activity.

Standard reports: configuration management
Sterling Control Center features reports that describe aspects of Sterling Control
Center server configuration management.

Functional Authorities Report
The Functional Authorities Report lists details about the functional authorities that
have been set up for Sterling Connect:Direct servers added to Sterling Control
Center.

The following table describes the report columns:

Column Description

Server Name Name of the selected server.

Functional Authority
Name

The name of the functional authority.

Version Version of the functional authority.

Parameter The functional authorities parameters selected for this report.

Value Parameter value.

For more information about parameters you can choose to report on in the
Parameter column, see Functional authorities field definitions in Configuration
Management.

Initialization Parameters Report
The Initialization Parameters Report lists initialization parameter (initparm) values
for selected servers. The listing is broken down by server and initialization
parameter version.

The following table describes the report columns:

Column Description

Server Name Name of the selected server.

Initialization Parameters
Name

This column simply reflects that the object being reported upon
is initialization parameters.
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Column Description

Version Version of the initialization parameters. Version indicates the
date and time that the initialization parameters were last
changed.

Parameter The specific initialization parameters that were selected for the
report.

Value Parameter value.

The set of parameters you can choose to report on in the Parameter column vary
depending on server operating system. Definitions of the parameters can be found
in the console in the form of tooltips. When you hover the cursor over an
initialization parameter its definition displays. You can find further detail on
initialization parameters in the Sterling Connect:Direct documentation for the
relevant platform (z/OS, UNIX, or Microsoft Windows).

Netmap Nodes Report
The Netmap Nodes Report lists all nodes in the netmap of selected servers.

The following table describes the report columns:

Column Description

Server Name Name of the selected server.

Netmap Node Name The name of the netmap node.

Version Version of the netmap node.

Parameter The netmap node parameters selected for this report.

Value Parameter value.

For more information about parameters you can choose to report on in the
Parameter column, see Manage netmap nodes in Configuration Management.

Netmap Modes Report
The Netmap Modes Report lists the netmap modes associated with selected
servers.

The following table describes the report columns:

Column Description

Server Name Name of the selected server.

Netmap Mode Name The name of the netmap mode associated with the server.

Version Version of the netmap mode.

Parameter The netmap mode parameters selected for this report.

Value Parameter value.

For more information about parameters you can choose to report on in the
Parameter column, see Manage netmap modes in Configuration Management.
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Netmap Communication Path Report
The Netmap Communication Path Report lists communication paths (comm paths)
associated with the nodes in a server's netmap.

The following table describes the report columns:

Column Description

Server Name Name of the selected server.

Netmap Communication
Path Name

The name of the communication path.

Version Version of the communication path.

Parameter The communication path parameters selected for this report.

Value Parameter value.

For more information about parameters you can choose to report on in the
Parameter column, see Manage Netmap Communication Paths in Configuration
Management.

Sterling Connect:Direct Secure Plus Nodes Report
The Sterling Connect:Direct Secure Plus Nodes Report lists details about the
Sterling Connect:Direct Secure Plus Nodes used by selected servers to move data
securely.

Following are the columns included in this report:

Column Description

Server Name Name of the server.

Sterling Connect:Direct Secure Plus Node
Name

Name of the key certificate.

Version Version of key certificate.

Parameter Parameters to include in the report.

Value Value of the parameter in question.

For more information about parameters you can choose to report on in the
Parameter column, see Manage Sterling Connect:Direct Secure Plus nodes in
Configuration Management.

Sterling Connect:Direct Secure Plus Key Certificates Report
The Sterling Connect:Direct Secure Plus Certificates Report lists Sterling
Connect:Direct Secure Plus key certificates (certs).

The following table describes the report columns:

Column Description

Server Name Name of the server.

Sterling Connect:Direct
Secure Plus Key
Certificate Name

Name of the key certificate.

Version Version of key certificate.
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Column Description

Parameter Parameters to include in the report. These include Data, Label
Name, and Passphrase.

Value The data contained in the certificate.

For more information about parameters you can choose to report on in the
Parameter column, see Manage Sterling Connect:Direct Secure Plus nodes in
Configuration Management.

Sterling Connect:Direct Secure Plus Trusted Certificates
Report

The Sterling Connect:Direct Secure Plus Trusted Certificates Report lists available
trusted certificates.

The following table describes the report columns:

Column Description

Server Name Name of the server.

Sterling Connect:Direct
Secure Plus Trusted
Certificate Name

Trusted certificate name.

Version Version of trusted certificate.

Parameter Trusted certificate parameter. Possible parameters include Data
and Label. Data is the trusted certificate data itself. Label name
is the name by which to identify the trusted certificate when it
is imported.

Value Parameter value.

Sterling Connect:Direct Secure Plus Cipher Suites Report
The Sterling Connect:Direct Secure Plus Cipher Suites Report lists the cipher suites
associated with Sterling Connect:Direct Secure Plus nodes.

The following table describes the report columns:

Column Description

Server Name Name of the server.

Sterling Connect:Direct
Secure Plus Cipher Suite
Name

Name of the cipher suite.

Version Cipher suite version.

Parameter Cipher suite parameter. These include SSL (Secure Sockets
Layer) and TLS (Transport Layer Security).

Value The possible values for the two parameters are true or false.

User Proxies Report
The User Proxies Report lists the user proxies associated with selected servers.

The following table describes the report columns:
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Column Description

Server Name Name of the selected server.

User Proxy Name The name of the user proxy.

Version Version of the user proxy.

Parameter The user proxy parameters selected for this report.

Value Parameter value.

For more information about parameters you can choose to report on in the
Parameter column, see Manage user proxies in Configuration Management.

Configuration Versions Report
The Configuration Versions Report lists the number of versions and the oldest
version that exist for configuration objects of selected Sterling Connect:Direct
servers.

The following table describes the report columns:

Column Description

Server Name The name of the selected server.

Configuration Object Type The type of configuration object.

Number of Versions The number of versions that exist for the configuration object.

Oldest Version The oldest version that exists for the configuration object.

Standard reports: monitoring
Sterling Control Center features reports that present details on the monitoring of
Sterling Control Center managed servers.

Sterling Connect:Direct Process Statistics Details Report
The Sterling Connect:Direct Process Statistics Details report contains detailed
statistics information about Processes occurring on managed Sterling
Connect:Direct servers during a specified time period.

Important: When you are creating the Sterling Connect:Direct Process Statistics
Details report, select Date/Time as the Sort option.

The following table describes the report columns:

Column Description

Bytes Sent The number of bytes sent by the sending node.

Date Time Date and time that the statistics records were generated.

Record ID Record identifier (also known as statistic ID). For a list of statistic
IDs, see Event type descriptions in System Administration.

Server Name Name of the managed server that generated the statistic record.

Remote Server Name of other server involved in the Process.

Process Name Sterling Connect:Direct Process name.

Process Number Identification number assigned to the Process.
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Column Description

Return Code Numeric code returned from a completed Process that indicates
failure or success. The following are the standard return codes:

v 0 indicates successful completion

v 4 indicates a warning

v 8 indicates an error

v 16 indicates a catastrophic error

Message ID Sterling Connect:Direct message identification number. See the
appropriate product and platform documentation for a description
of message IDs.

Message Text Short message text associated with the message ID.

Destination File
Name

Path and file name for the file received.

Sterling Connect:Direct Process Statistics Summary
The Sterling Connect:Direct Process Statistics Summary report contains summary
statistics about Processes occurring on managed Sterling Connect:Direct servers
during the specified time period.

Important: When you are creating the Sterling Connect:Direct Process Statistics
Summary report, select Date/Time as the Sort option.

The following table describes the report columns:

Column Description

Date Time Date and time that the statistics record was generated.

Server Name Name of the managed server that generated the status record.

Process Name Sterling Connect:Direct Process name.

Process Number Identification number assigned to each Process.

Submitter User ID of the user who submitted the Process.

Return Code Numeric code returned from a completed Process that indicates failure
or success. The following are the standard return codes:

0 indicates successful completion

4 indicates a warning

8 indicates an error

16 indicates a catastrophic error

Msg ID Sterling Control Center or Sterling Connect:Direct message identification
number. See the appropriate product documentation for a description of
message IDs.

Message Text Short message text associated with the message ID.

Sterling Connect:Direct Statistics Log Report
The Database Sterling Connect:Direct Statistics Log Report allows you to compose
a report of database statistical data based on the information that is important to
you.
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You choose the database fields to display and their sort order. You can also state
filter criteria to limit the records to include in the report. Filter criteria include any
of the database statistics fields except for CC Name.

Sterling Connect:Enterprise Batch Statistics Details Report
The Sterling Connect:Enterprise Batch Statistics Details Report contains detailed
information about batches on managed Sterling Connect:Enterprise servers during
the specified time period.

The following table describes the report columns:

Column Description

Start Date Time Date and time that start-of-batch transmission information is received by
the Sterling Control Center engine.

End Date Time Date and time that end-of-batch transmission information is received by
the Sterling Control Center engine.

Server Name The server involved in the batch transmission.

Message ID Message ID resulting from the batch Process.

Status Batch status.

Mailbox ID Repository associated with the Sterling Connect:Enterprise batch

Batch ID User-assigned description of a Sterling Connect:Enterprise batch.

Batch Number System-assigned number for each batch in a Sterling Connect:Enterprise
repository.

Size Size of the batch file.

Flags Sterling Connect:Enterprise batch status flag. See the appropriate Sterling
Connect:Enterprise documentation for a list of batch status flags.

Function Function performed on the batch. See the Sterling Connect:Enterprise
documentation for a description of functions.

Sterling Connect:Enterprise Batch Statistics Summary Report
The Sterling Connect:Enterprise Batch Statistics Summary report contains summary
information about batches on managed Sterling Connect:Enterprise servers during
the specified time period.

The following table describes the report columns

Column Description

Start Date Time Date and time that start-of-batch transmission information is received by
the Sterling Control Center engine.

End Date Time Date and time that end-of-batch transmission information is received by
the Sterling Control Center engine.

Server Name The server involved in the batch transmission.

Message ID Message ID resulting from the batch Process.

Status Batch status.

Mailbox ID Repository associated with the Sterling Connect:Enterprise batch.

Batch ID User-assigned description of a Sterling Connect:Enterprise batch.

Function Function performed on the batch. See the Sterling Connect:Enterprise
documentation for a description of functions.
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Column Description

Batch Number System-assigned number for each batch in a Sterling Connect:Enterprise
repository.

Sterling Connect:Enterprise Statistics Log Report
The Sterling Connect:Enterprise Statistics Log Report allows you to compose a
report of database statistical data based on the information that is important to
you.

You choose the database fields to display and their sort order. You can also state
filter criteria to limit the records to include in the report. Filter criteria include any
of the database fields except for CC Name.

Sterling Connect:Express Process Statistics Details
The Sterling Connect:Express Process Statistics Details report contains detailed
statistics information about processes occurring on managed Sterling
Connect:Express servers during a specified time period.

The following table describes the report columns:

Column Description

Date Time Date and time that the statistics records were generated.

Server Name Name of the managed server that generated the statistic record.

Remote Node Name of other server involved in the Process.

Process Name Sterling Connect:Express process name.

Process Number Identification number assigned to the process.

Submitter User ID of the user who submitted the process.

Return Code Numeric code returned from a completed process that indicates
failure or success. The following are the standard return codes:

v 0 indicates successful completion

v 4 indicates a warning

v 8 indicates an error

v 16 indicates a unrecoverable error

Message ID Sterling Connect:Express message identification number. See the
appropriate product and platform documentation for a description
of message IDs.

Message Text Short message text associated with the message ID.

Remote Node Name of other server involved in the process.

Destination File
Name

Path and file name for the file received.

Bytes Sent The number of bytes sent by the sending node.

Sterling Connect:Express Process Statistics Summary
The Sterling Connect:Express Process Statistics Summary report contains summary
statistics about processes occurring on managed Sterling Connect:Express servers
during the specified time period.

The following table describes the report columns:
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Column Description

Date Time Date and time that the statistics record was generated.

Server Name Name of the managed server that generated the status record.

Process Name Sterling Connect:Express process name.

Process Number Identification number assigned to each process.

Submitter User ID of the user who submitted the process.

Return Code Numeric code returned from a completed process that indicates failure
or success. The following are the standard return codes:

v 0 indicates successful completion

v 4 indicates a warning

v 8 indicates an error

v 16 indicates a unrecoverable error

Message ID Sterling Control Center or Sterling Connect:Express message
identification number. See the appropriate product documentation for a
description of message IDs.

Message Text Short message text associated with the message ID.

QuickFile File Transfer Report
The QuickFile File Transfer Report presents information on file transfer activity for
QuickFile servers managed by Sterling Control Center.

The following table describes the columns included in this report:

Column Description

Date/Time Date and time of the transfer.

Package Subject of the QuickFile file transfer.

File Name Name of the file being transferred.

File Size Size of the file transferred, in bytes.

User Name of the user who sent the file.

User ID User ID of the user who submitted the Process.

Event A QuickFile event, for example, whether the file was sent
or downloaded.

Status Code QuickFile status for the file transfer.

Total Files Total numbers of files transferred.

Total Size Total size of files transferred, in bytes.

QuickFile Users Details Report
The QuickFile Users Details Report contains statistics information about users
transferring files with QuickFile.

The following table describes the report columns:

Column Description

Date/Time Date and time that the statistics records were generated.

Package Subject of the QuickFile file transfer.

File Name Name of the file being transferred
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Column Description

File Size Size of the file being transferred.

User Email address of the QuickFile user who triggered the file transfer.

Registered User has completed the QuickFile registration process. True | False

Sender User who sent the file.

Recipient User who received the file.

Event Type of system event. Sent | Downloaded.

Status Code QuickFile status for the file transfer.

FTP File Transfer Report
The FTP File Transfer Report presents information on file transfer activity for FTP
servers managed by Sterling Control Center.

The following table describes the columns included in this report:

Column Description

Event Date/Time Date and time of the transfer.

Process ID Process identifier for the Process used to transfer the file.

Return Code Return code returned for the file transfer.

Direction Direction of the file transfer with respect to the FTP server.

File Size Size of the file transferred, in bytes.

Submitter User ID of the user who submitted the Process.

Source Server from which the file was transferred (submitter for
FTP PUTs).

Destination Server to which the file was transferred (submitter for FTP
GETs).

MQ MFT File Transfer Report
The MQ MFT File Transfer Report presents information on file transfer activity for
MQ MFT servers managed by Sterling Control Center.

The following table describes the columns included in this report:

Column Description

Date Time Date and time of the transfer.

Server Name Name of the MQ MFT server.

Process Name Name of the process.

Process ID Process identifier.

Submitter User ID of the user who submitted the process.

Return Code Return code returned for the file transfer.

Message ID The identifier for the message associated with the event.

Message Text The text for the message associated with the event.

Source Agent Name of the source MQ MFT agent that sent the file.

Source File Name Path and file name for the file sent.
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Column Description

Destination Agent Name of the agent that received the file.

Destination File Name Path and file name for the file received.

File Size in Bytes Size of the file transferred.

Sterling File Gateway Route Detail by Producer Report
The Sterling File Gateway Route Detail by Producer report presents detailed
information on route activity by producer for Sterling File Gateway servers.

The fields that make up this report are described in the following table.

Field Description

Producer The name of the partner who created and sent the arrived file involved
in the Sterling File Gateway file transfer.

Server The name of the Sterling File Gateway server being monitored.

Arr File Name The name of the arrived file involved in the Sterling File Gateway file
transfer.

Status The status of the arrived file involved in the Sterling File Gateway file
transfer.

v Arrived

v Failed

v Ignore

Consumer The name of the partner who received the arrived file involved in the
Sterling File Gateway file transfer.

Consumer File The name of the file the consumer expects in their mailbox when
delivery is completed.

File Size Size of file transferred, in bytes.

Start Time The date and time the file transfer started.

End Time The date and time the file transfer ended.

Sterling File Gateway Route Detail by Consumer Report
The Sterling File Gateway Route Detail by Consumer report presents detailed
information on route activity by consumer for Sterling File Gateway servers.

The fields that make up this report are described in the following table.

Field Description

Consumer Name of the partner who received the file involved in the File Gateway
file transfer.

Consumer File The name of the file the consumer expects in their mailbox when
delivery is completed.

File Size Size of file transferred, in bytes.

Status The status of the arrived file involved in the File Gateway file transfer.

v Arrived

v Failed

v Ignore
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Field Description

Producer The name of the partner who created and sent the arrived file involved
in the File Gateway file transfer.

Arr File Name The name of the arrived file involved in the File Gateway file transfer.

Start Time The date and time the file transfer started.

End Time The date and time the file transfer ended.

Sterling B2B Integrator Business Process Details Report
The Sterling B2B Integrator Business Process Details Report presents detailed
information on business process activity for Sterling Integrator servers.

The fields that make up this report are described in the following table.

Field Description

Event Date/Time Date and time that the event was generated.

Event Type The type of event generated.

Node ID The identifier for the node that generated the business process.

Node Name The name of the node that generated the business process.

Process Name The name of the process.

Process ID The process identifier.

Event Return
Code

The code returned by the process.

Message ID The identifier for the message associated with the event.

Step Name The step name associated with the event.

Step ID The identifier for the step associated with the event.

Advanced Status Service-specific details about any errors that occurred for a step in this
instance.

For list of advanced status messages, see the Sterling B2B Integrator
product documentation.

Sterling B2B Integrator Business Process Summary Report
The Sterling B2B Integrator Business Process Summary Report presents summary
information on business process activity for Sterling Integrator servers.

The fields that make up this report are described in the following table:

Field Description

Event Date/Time Date and time that the event was generated.

Event Type The type of event generated.

Node ID The identifier for the node that generated the business process.

Node Name The name of the node that generated the business process.

Process ID The Process identifier.

Process Name The name of the Process.

Event Return Code The code returned by the Process.

Message ID The identifier for the message associated with the event.
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Field Description

Advanced Status Service-specific details about any errors that occurred for a step
in this instance.

For list of advanced status messages, see the Sterling B2B
Integrator product documentation.

Sterling B2B Integrator File Transfer Report
The Sterling B2B Integrator File Transfer Report presents summary information on
communications activity for Sterling Integrator servers.

The fields that make up this report are described in the following table:

Field Description

Event Date/Time Date and time that the event was generated.

Adapter Name Name of the Sterling B2B Integrator adapter that generated the event.

Process Name The name of the process.

Process ID The process identifier.

Return Code The code returned by the process.

Message ID The identifier for the message associated with the event.

Orig Node The originating node for the process.

Remote Node The receiving node for the process.

Direction The direction of the transfer

File Size The size of file transferred.

Submitter ID The identifier for the process submitter.

Protocol The protocol used for the transfer.

Secure Mode A flag indicating whether the transfer was accomplished via a secure
connection.

High Watermark Report
The High Watermark Report provides information to help manage Sterling
Connect:Direct licenses or node usage, perform audits of usage, or meet other
reporting needs.

Server licenses often stipulate a maximum number of simultaneous sessions that
can run on a server. You can use the report to determine whether the number of
sessions a Sterling Connect:Direct node is licensed for are ever reached and, if so,
how often and for what periods. Do this by setting the report limit equal to the
license limit.

The High Watermark Report can also be used to see how many times sessions
would be queued if the number of concurrent sessions allowed were reduced. To
do this, set the report session limit to a value lower than the license limit.

In some cases Sterling Connect:Direct licenses specify an overall limit on the
number of simultaneous sessions, as opposed to a limit for each server. You can
use the report in these cases as well, to see whether you are violating your license
agreement. Or use the report to determine what would happen if the limit on
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simultaneous sessions were raised or reduced. The # Times sessions exceeded limit
column tells how many processes would have been queued to run later if the
session limit were enforced.

Note: The more times processes are queued instead of run immediately, the more
times your processing window for file transfers may be missed.

The start time of the longest period over limit, in conjunction with the Last time
max reached, can serve as an indicator of when the most Sterling Connect:Direct
processing is occurring on your systems.

Max Concurrent Sessions indicates the maximum number of processes that ran at
the same time. The # Times max reached column can indicate whether or not the
maximum number of processes running at one time was an aberration or whether
it happens frequently. By reducing the report limit, you can determine the typical
number of processes running simultaneously by watching for an increase in the #
Times max reached value.

You can restrict High Watermark Report output to a range of dates and times, to
specific servers or server groups, and to a session limit. Default filter criteria preset
for this report include Limit, Max Process Duration, Data/Time, and Servers. You
can change the presets at the time of creation. Servers is the only one required.

After you confirm your choices and run the report, a status window displays the
time elapsed since the report was initiated, along with start date/time and end
date/time criteria. A progress bar depicts report generation progress and shows the
date of the last statistics record processed.

Note: High Watermark reports may require an extended time to run. Select
Background to perform other Sterling Control Center tasks. You can stop the
report by selecting Stop. When the report is complete, select Show Report.

The report includes detailed statistics for each selected server or server group as
well as summary statistics across all selected servers.

The following table describes the columns of the High Watermark Report.

Column Description

* An asterisk next to a server ID indicates that a process on
this server has exceeded the maximum duration.

Server Name The server ID.

Max Concurrent Sessions The peak number of sessions reached during the selected
period.

# Times Max Reached The number of occurrences within the selected period that
Max Concurrent Sessions was reached.

Last Time Max Reached The date and time of the last point when Max Concurrent
Sessions was reached.

# Times Above Limit The number of times the specified session limit was
exceeded.

# Times Sessions Exceeded
Limit

The number of sessions initiated while the session
concurrency count was at or above the session limit.

Last Time Limit Exceeded The date and time of the point when the limit was last
exceeded (not the point when concurrent sessions returned
below the threshold).
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Column Description

Start Time of Longest Period
Over Limit

The date and time when the longest over limit period
began.

Longest Period Over Limit The amount of time in the longest over limit period.

% Time Over Limit The percent of the total date/time range that the server or
servers spent over the limit.

# Processes Exceeding Max
Duration

How many processes have exceeded the maximum process
duration.

Longest Process Exceeding
Max Duration

The running time for the process that has furthest exceeded
the maximum process duration.

High Watermark Report considerations
The following section is an explanation of the High Watermark Report.

The statistics featured in the High Watermark Report may prove easier to
understand by viewing a series of graphics that show sessions starting and ending
over a time span. In the examples, the time span covers 19 generic units. The
report is based on the following series of events, which occurred on a managed
server.

Time Event Time Event

1 Process Start 9 Process End

2 Process Start 10 Process Start

2 Process Start 11 Process Start

3 Process End 12 Process Start

3 Process End 14 Process End

4 Process Start 15 Process Start

4 Process Start 16 Process End

6 Process Start 17 Process End

7 Process End 18 Process End

8 Process End
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In the previous illustration:
v Start Time of Longest Period Over Limit = 11
v Longest Period Over Limit = 6 time units
v Percent Time Over Limit = (1+4+6 units) / 19 units = 57.89%

All Servers Statistics. On the High Watermark Report, the results detailed for All
Servers may not make intuitive sense at first glance. The source of the confusion
has to do with the nature of what is being quantified.

For example, take a High Watermark Report run against two nodes, A and B, each
with a session limit of 1. If the two nodes behave identically, as in the following
graphic, each will have a number of sessions over the limit equal to two.

However, the number of sessions in which the two combined are over the limit is
six, as shown in the next graphic. Therefore, the report column # Times Sessions
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Exceeded Limit will show a value of 6 for All Servers.

Keep in mind these information when using and interpreting the High Watermark
Report.
v If the clocks are not accurate for all managed servers included in the report, the

values for All Servers may not be accurate.
v For Sterling Connect:Direct for Microsoft Windows version 4.2, in the absence of

the fix for SR1343840, whenever Processes are put on the wait, hold, or timer
queues, they are treated as still running. This may affect the accuracy of the
report. No fix is needed with later versions of Sterling Connect:Direct for
Microsoft Windows.

During the report's specified time frame, if one or more Processes exceed the Max
Process Duration value specified, the report's accuracy will be affected.

Sterling Connect:Direct File Agent Process Submission Report
The Sterling Connect:Direct File Agent Process Submission Report presents
information on Processes submitted by file agents associated with a managed
Sterling Connect:Direct server.

The fields that make up this report are described in the following table:

Field Description

Date / Time Date and time that the event was generated.

Server Name ID of the server the file agent submitted the process to.

File Agent Name The identifier of the file agent.

Process Name The name of the submitted Process.

Process Number Number of the submitted Process.

Return Code The code returned by the Process.

Trigger File The name of the file that triggered the Sterling Connect:Direct File
Agent to submit a Process.
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Field Description

Rule Name The name of the Sterling Connect:Direct File Agent rule that triggered
the event.

Standard Reports: node discovery
Sterling Control Center features reports that give details on aspects of Sterling
Control Center node discovery.

Potentially Inactive Netmap Entries Report
The Potentially Inactive Netmap Entries Report lists nodes identified during Node
Discovery that were found in the network map file of an Explorer node but on
which no statistics records were found.

Use this information to determine if you need to remove these node definitions
from the network map of the corresponding Explorer node after validating that the
connections to these nodes are no longer required.

The following table describes the report columns

Column Description

Server Name of the Sterling Connect:Direct server.

Potentially Inactive Netmap
Entry for Node(s)

The network map entry that may be inactive.

Potentially Missing Netmap Entries Report
The Potentially Missing Netmap Entries report identifies the nodes that were
found in the statistics records of the Explorer node but were not defined in the
network map file.

Use this information to determine if you need to add these node definitions to the
network map of the corresponding server.

The following table describes the report columns:

Column Description

Server Name of the Sterling Connect:Direct server.

Potentially Missing Netmap
Entry for Node(s)

The nodes found in statistics records that were not defined
in the network map.

Netmap Connections Summary Report
The Netmap Connections Summary Report contains a summary of all connection
information collected during node discovery.

The following table describes the report columns

Column Description

Server Name Name of the Sterling Connect:Direct servers.

Netmap Entries The number of network map entries defined.
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Column Description

Last Used Date/Time The last time the server connected with another node.

API Address The TCP/IP address and port used by Sterling Control Center to
establish a session with the Sterling Connect:Direct server.

DTF Address The TCP/IP address and port of the server that a remote Sterling
Connect:Direct server uses to establish a connection.

Platform The platform on which the server is running.

Number of Partner
Nodes

The number of partner nodes defined in the network map and the
statistics records of the server.

Explorer/Discovered The type of node. E = nodes defined in the Explorer List and D =
nodes located in the Discovery List.

Node Discovery Topology Report
The Node Discovery Topology report contains information about the partners
associated with the specified Explorer node.

The following table describes the report columns

Column Description

Explorer Node Name The name of the server defined in the Explorer List.

API Address The TCP/IP address and port used by Sterling Control
Center to establish a session with the Sterling Connect:Direct
server.

DTF Address The TCP/IP address and port of the server that a remote
Sterling Connect:Direct server uses to establish a connection.

Platform The platform on which the server is running.

License Key Expiration Date The date the license key expires for the node.

Last Explored Date Range The date range used to search the last time that Node
Discovery was run.

Last Explored Date/Time The date and time that Node Discovery was last run.

# Partners The number of partner nodes defined in the network map
and found in statistics records for the server.

# Processes The number of Processes found in the statistics records
during Node Discovery.

Discovered Node Name The name of a server found during Node Discovery.

Found in
Netmap/Stats/Both

Identifies where the discovered node was found: either
defined in the network map, in a statistics record, or
identified in both the network map and a statistics record.

IP Address/APPL ID The IP address or the APPL ID for SNA-enabled nodes.

Data Transfer Port The port used for data transfer.

Platform The platform on which the discovered node is running.

Last Used Date/Time The time stamp of the communications between server pair
under consideration.

# Explorer Partners The number of Explorer nodes that this node communicates
with.

# Processes The number of Processes found in the statistics record for
the server pair under consideration.
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Standard Reports: system
Sterling Control Center features reports that detail aspects of overall system
functioning.

Alerts Report
The Alerts Report contains information about alerts generated by Sterling Control
Center on managed servers during a specified time period.

The report includes any comments that may have been entered for an alert. For
more information about alert comments, see Updating alerts in User.

The following table describes the report columns:

Column Description

Alert Date Time Date and time that the alert was generated.

Severity Alert severity level. (0–3)

Server Name Name of the managed server on which the alert was generated.

Proc/Batch
Name

Process name or Batch ID that generated the alert.

Proc Number Process or batch number that generated the alert.

Rule Name Rule that triggered the alert.

User Data 1–4 User-definable metadata fields. See Metadata rules overview in System
Administration.

Handled Time Time that the alert was handled.

Alert Handled A flag indicating whether the alert was handled (Y/N).

Handled By User ID of the Sterling Control Center user who handled the alert.

Comments User comments supplied when the alert was handled.

Audit Log Report
The Audit Log Report lists changes that have been made to the configuration of
one or more Sterling Connect:Direct servers managed by Sterling Control Center.

The following table describes the report columns.

Column Description

Date Time Date and time of the change.

User User ID of the user who made the change.

Server The server the change affected.

Object ID The identifier of the object that was changed.

Object Type The type of object changed.

Property The specific property of the object that was changed.

Type Type of property change: Added, Modified, or Deleted.

Value Before The value of the property before the change.

Value After The value of the property after the change.
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Server Status Report
The Server Status report contains system status information about selected
managed servers.

The following table describes the report columns:

Column Description

Server Name Name of the managed server.

Alerts Number of active high, medium, and low severity alerts on the
server.

Server Version Version of the server.

License Expire Date Date that the managed server's software license expires.

License Type Type of product license on the server.

License Notification How many days before a server license expiration date that Sterling
Control Center begins generating license expiration events.

Sessions/ Accounts Number of concurrent sessions or accounts permitted by the server
license.

Max Processes
Permitted/Time
Max Reached

Maximum number of concurrent sessions that have occurred on the
server / Number of times the maximum number of concurrent
sessions was reached.

Processes Exec Number of executing Processes on the server. This is shown for
Sterling Connect:Direct servers only.

Processes Non-Exec Number of non-executing Processes on the server. This is shown for
Sterling Connect:Direct servers only.

Server Inventory Report
The Server Inventory Report prints an inventory of the servers monitored and
managed by Sterling Control Center.

Following is a description of the columns that make up the report.

Column Description

Server Name The name of the server.

Server Type Type of server (Sterling Connect:Direct, Sterling Connect:Enterprise,
Sterling B2B Integrator, File Transfer Protocol).

Description Server description.

Server Version Server platform.

Current Status The current status of the server.

Monitor This server is monitored by Sterling Control Center. X indicates Yes,
blank indicates No.

Configure This server is configurable by Sterling Control Center. X indicates
Yes, blank indicates No.

License Push This server supports license push by Sterling Control Center. X
indicates Yes, blank indicates No.

Sterling
Connect:Direct Secure
Plus

This server supports Sterling Connect:Direct Secure Plus. X
indicates Yes, blank indicates No.

License Expiration Expiration date for this server's current license.
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Column Description

License Type Type of current license.

License PSP Software product ID, to uniquely identifies a specific licensed copy
of software.

Service Level Criteria Summary Report
The SLC Summary Report lists details regarding each Sterling Control Center SLC.

The following table describes SLC Summary Report columns:

Column Description

SLC Type Standard, Wildcard, or Workflow

ID The name of the SLC.

Enabled Whether or not the SLC is enabled.

Monitoring Window The SLC's monitoring window parameters.

Matching Properties The matching criteria for items being monitored.

Cal. Sched. The calendar schedule used in setting up the SLC.

Enabled Whether or not the calendar schedule is enabled.

Dur Schedule Duration schedule.

Milestone ID Identifier of the workflow SLC milestone.

Database Events Report
The Database Events Report allows you to compose a report of database event
data based on the information that is important to you.

You choose the database fields to display and their sort order. You can also state
filter criteria to limit the records to include in the report. Filter criteria include any
of the database fields except for CC Name.

Monthly File Transfer Activity Report
The Monthly File Transfer Activity Report lists details regarding monthly file
transfer activity on selected Sterling Connect:Direct servers.

Following are the columns that make up the Monthly File Transfer Activity Report.

Column Description

Server Name Name of server.

Date Date of file transfer.

Files Sent Number of files sent.

Files Received Number of files received.

File Bytes Number of bytes in files involved in the transfer.

Transmitted Bytes Number of bytes transmitted in the transfer.
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Users and Roles Summary Report
The Users and Roles Summary report is a three-part report.

The Users and Roles Summary report lists the following information:
v All Sterling Control Center users and their associated roles
v All Sterling Control Center roles and the users assigned to them
v All Sterling Control Center roles and their associated permissions

The following table describes the report columns:

Column Description

Part 1

User ID Sterling Control Center user.

User Role Role assigned to the user.

Description Description text provided for the user ID.

Last Login Time Date and time that the user last logged into Sterling Control
Center.

Host The host through which the user last logged in.

IP Address The IP address of the computer on which user last logged in.

Domain The domain of the computer on which user logged in.

Active Whether the user was active when the report was run (Y/N).

Part 2

User Role Roles defined in Sterling Control Center.

Assigned User IDs User IDs assigned to the role.

Part 3

User Role Roles defined in Sterling Control Center.

Role Authority Server groups and permissions assigned to the role.
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Chapter 3. Displaying the Audit Log

You can display the Audit Log to see changes made to IBM Sterling Connect:Direct
server configuration objects.

About this task

To display the audit log:

Procedure

Select Tools > Audit Log. The Audit Log window displays all objects that have
changed. The listing includes the properties of the object that have changed and
when, as well as the values before and after the change. You can filter this list or
save it to disk.
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Chapter 4. Sample Reports in Crystal Reports Format

Sterling Control Center provides the several sample reports in Crystal Reports
format.

Note: IBM does not provide assistance for implementing report solutions in all
environments using all possible third-party tools, including Crystal Reports Viewer.
The sample reports provided in the Sterling Control Center package are designed
to act as a starting point for designing your own reports using the tools of your
choice.

Configuring ODBC DSN for the sample Crystal reports
To use the sample Crystal Reports, you must configure an ODBC DSN as
described here.

About this task

To perform this procedure, you must already have installed Sterling Control Center
with a database.

To configure your computer before using the sample Sterling Control Center
reports:

Procedure
1. Download and install the ODBC driver for your database type.
2. After the driver is installed, select Start > Control Panel > Administrative

Tools > Data Sources (ODBC) to display the ODBC Data Source Administrator
window.

3. Select the System DSN tab.
4. Click Add.
5. Select the appropriate driver from the driver list and click Finish.
6. Type the following information and click OK.

Results

Field Description

Data Source Name IBMSterling

Type the name in the exact case shown above. Do not include a space.

Host/Server Name
(or IP)

IP address of the Sterling Control Center database (production or
staging).

Database name Name of the Sterling Control Center database (production or staging).

User User name to access the Sterling Control Center database (production
or staging).

Password Password to access the Sterling Control Center database (production
or staging).

Port Port number to access the Sterling Control Center database
(production or staging).
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Note: The configuration parameters may vary depending on the database type.

Using a later version of Crystal reports for sample reports
Sterling Control Center reports are created using Crystal Reports version 9.0. If you
use a later version of Crystal Reports to generate Sterling Control Center reports,
perform the following procedure to convert the sample reports.

About this task

Note: The following procedure is not a substitute for the actual product
documentation for Crystal Reports.

This procedure assumes that you have already connected to the database.

To convert the sample reports using a version of Crystal Reports later than 9.0:

Procedure
1. Open a report.
2. Select Database.
3. Select Show SQL Query.
4. Click OK on the Enter Parameter Values window.
5. Click OK on the Verify Database message.
6. Click OK on the database is up to date message.
7. Click Reset, then click OK on the Show SQL Query window.
8. Save the report under a new name. Use this report in the future. The report is

saved in the later version of Crystal Reports.
9. Repeat this procedure for each report.

Running the Sterling Control Center Sample Reports
Follow this procedure to run sample reports.

About this task

To run the sample reports included with Sterling Control Center:

Procedure
1. Copy the SampleReports folder from the Sterling Control Center DVD or the

Sterling Control Center folder downloaded from the IBM website to the desired
directory on your desktop.

2. Start Crystal Reports.
3. Select File > Log On/Off Server. The Data Explorer window is displayed.
4. Expand the ODBC folder.
5. Select the IBMSterling ODBC DSN and click Log On.

Note: Log on to the IBMSterling ODBC DSN each time you start Crystal
Reports before you run a report.

6. Open a sample report from the SampleReports directory and run it.
7. Select the report criteria and click OK. The report is displayed on your monitor.
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Troubleshooting Sterling Control Center Sample Reports
When running the Sterling Control Center sample reports, you may receive a
database ODBC error.

About this task

If you receive such a message, follow this procedure.:

Procedure
1. Select Database > Show SQL Query from the Crystal Reports menu bar.
2. Select the Show SQL Query tab.
3. Click Reset.
4. Generate the report again.

Sample reports
Crystal Reports creates several reports for Sterling Control Center.

All Crystal Reports sample reports must be printed on 14-inch wide paper.

Sterling Connect:Direct Events Report
The Sterling Connect:Direct Events Report contains information about events
occurring on managed servers during the specified time period.

The file name for this report is CD_Select_Events.rpt.

The following table lists selection criteria for this report:

Criteria Description

Event Type Sterling Control Center event to show on the report. For a description
about event types, see System Administration.

To include an event, select the event from the list box and click Add. You
can select multiple events for the report.

Start Date Start date of the data range.

End Date End date of the data range.

Start Time Start time of the data range. The default is 00:00:00 (midnight).

End Time End time of the data range. The default is 23:59:59.

The following table describes the report columns:

Column Description

Date/Time Date and time that the event was generated.

Node ID Server alias.

Event Type Type of event. For a description about event types, see System
Administration.

Alert Indicates if an alert was triggered. The values are:

v Blank=No alert

v 0-3=Alert severity
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Column Description

Alert Deleted By Sterling Control Center user name of the person who removed the alert.

Rule ID Name of the rule triggered by the event.

Action ID Name of the action called by the rule.

Msg ID Server or Sterling Control Center message ID issued with the event.

Msg Short Text Message short text for the message ID.

Sterling Connect:Direct Exception Trends Report
The Sterling Connect:Direct Exception Trends report lists exception counts by
category (such as failed Process steps or Copy steps) during a specified time
period. You can specify the report by month, week, day, or hour. This report is in
date/time order.

The file name for this report is CD_Exception_Trends_By_Period.rpt.

The following table lists selection criteria for this report:

Criteria Description

Period Time period that the data is summarized by: monthly, weekly, daily,
and hourly.

Start Date Start date of the data range.

End Date End date of the data range.

Start Time Start time of the data range. The default is 00:00:00 (midnight).

End Time End time of the data range. The default is 23:59:59.

The following table describes the report columns:

Column Description

Processes Total Total number of Processes (failed and successful) for the specified
time period.

Processes Failed Number of Processes for the specified time period that completed
with completion code greater than 0.

Processes % Failed Percentage of Processes for the specified time period that completed
with completion code greater than 0.

Copy Steps Total Total number of Copy steps (failed and successful) for the specified
time period.

Copy Steps Failed Number of Copy steps for the specified time period that completed
with completion code greater than 0.

Copy Steps % Failed Percentage of Copy steps for the specified time period that
completed with completion code greater than 0.

Run Tasks Total Total number of Run Task steps (failed and successful) for the
specified time period.

Run Tasks Failed Number of Run Task steps for the specified time period that
completed with completion code greater than 0.

Run Tasks % Failed Percentage of Run Task steps for the specified time period that
completed with completion code greater than 0.

Run Jobs Total Total number of Run Job steps (failed and successful) for the
specified time period.
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Column Description

Run Jobs Failed Number of Run Job steps for the specified time period that
completed with completion code greater than 0.

Run Jobs % Failed Percentage of Run Job steps for the specified time period that
completed with completion code greater than 0.

Submit Steps Total Total number of Submit steps (failed and successful) for the specified
time period.

Submit Steps Failed Number of Submit steps for the specified time period that
completed with completion code greater than 0.

Submit Steps %
Failed

Percentage of Submit steps for the specified time period that
completed with completion code greater than 0.

Sterling Connect:Direct Exception Trends Chart
The Sterling Connect:Direct Exception Trends Chart is nearly identical to the
Sterling Connect:Direct Exception Trends Report.

The only difference is that this report displays the following graphs on the first
page:
v Daily total Copy steps (successful and failed)
v Daily percentage of failed Copy steps

The file name for this report is CD_Charts_Bar_Copy and PctFail_ByDay.rpt.

The selection criteria and report columns for this report are the same as the
Sterling Connect:Direct Exception Trends report.

Sterling Connect:Direct Usage Report
The Sterling Connect:Direct Usage Report details Process activity during a
specified time period.

You can select to show all Sterling Connect:Direct activity or exception processing
only. This report is in date/time order.

The last page of the report summarizes totals and average run time for Processes,
Copy steps, Run Jobs, Run Tasks, and Submit steps, and file transfer information
for the report.

The file name for this report is CD_Usage_and_Exceptions.rpt.

The following table lists selection criteria for the Sterling Connect:Direct Usage
Report:

Criteria Description

Exceptions Only
(Y/N)

Indicates if the report shows all Sterling Connect:Direct activity or
exception processing only.

Start Date Start date of the data range.

End Date End date of the data range.

Start Time Start time of the data range. The default is 00:00:00 (midnight).

End Time End time of the data range. The default is 23:59:59.
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The following 2 tables describe the report columns.

Column Description

Log Date Time Date and time that the statistics record was written to the log file.
Format yyyy/mm/dd hh:mm:ss.msmsms.

Rec Type Type of statistics record generated. See the Event Type Descriptions topic
in the Help for a list of record IDs.

PNODE Primary node name.

Dir Data transfer or command direction.

==> indicates from the PNODE to the SNODE.

<== indicates from the SNODE to the PNODE.

SNODE Secondary node name.

Proc Name Sterling Connect:Direct Process name.

Proc Nbr Sterling Connect:Direct Process number.

Step Name Process step.

Duration Amount of time the step took. Format hh:mm:ss.

CC Condition code associated with step termination. Typical codes are:

0=Successful execution.

4=A warning level error was encountered. The statement probably
finished normally, but you should verify the execution results.

8=An error occurred during execution.

16=A catastrophic error occurred during execution.

Msg ID Server or Sterling Control Center message ID issued with the event.

File Name Name of the transferred file. Depending on the step, this can be either
the source or destination file name.

These are the columns that display on the summary page:

Column Description

Total Total number (successful and failed) of Processes, Copy steps, Run Job
Steps, Run Task steps, and Submit steps for the specified time period.

Successful Number of Processes, Copy steps, Run Job Steps, Run Task steps, and
Submit steps that completed with a condition code of 0 for the specified
time period.

Failed Number of Processes, Copy steps, Run Job Steps that completed with a
condition code greater than 0 for the specified time period.

% Failed Percentage of Processes, Copy steps, Run Job Steps that completed with
a condition code greater than 0 for the specified time period.

Average Time Average time for a Process, Copy step, Run Job Step, Run Task step, and
Submit step for the specified time period. This average includes all
successful and failed Processes and steps.

Bytes Sent Total number of bytes read from source files for the specified time
period for all Copy Steps.

Bytes Received Total number of bytes received by destination files for the specified time
period for all Copy Steps.
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Column Description

Avg Send Rate
(Bytes/Sec)

Average send rate in bytes/second for all Copy Steps.

Avg Receive
Rate (Bytes/Sec)

Average receive rate in bytes/second for all Copy Steps.

Sterling Connect:Direct Usage Report Chart
The Sterling Connect:Direct Usage Report Chart is nearly identical to the Sterling
Connect:Direct Usage Report.

The only difference is that the last page of this report displays two pie charts
categorizing usage by step type and failed step type.

You can select to show all Sterling Connect:Direct activity or exception processing
only. This report is in date/time order.

The next-to-last page of the report summarizes totals and average run time for
Processes, Copy steps, Run Jobs, Run Tasks, and Submit steps, and file transfer
information for the report.

The file name for this report is CD_Charts_Pie _Usage_and_Exceptions.rpt.

The selection criteria and report columns for this report are the same as for the
Sterling Connect:Direct Usage Report.

Sterling Connect:Direct Usage by Server Pair Report
The Sterling Connect:Direct Usage by Server Pair Report summarizes by
PNODE-SNODE the type of activity occurring during a specified time period.

This report is in alphabetic PNODE-SNODE pair order.

You can select to show all Sterling Connect:Direct activity or exception processing
only.

You can see the detail for any summary item by double-clicking the item.

The file name for this report is CD_Usage_By_ServerPair_and_Exceptions.rpt.

The following table lists selection criteria for the Sterling Connect:Direct Usage by
Server Pair Report:

Criteria Description

Exceptions Only
(Y/N)

Indicates if the report shows all Sterling Connect:Direct activity or
exception processing only.

Start Date Start date of the data range.

End Date End date of the data range.

Start Time Start time of the data range. The default is 00:00:00 (midnight).

End Time End time of the data range. The default is 23:59:59.

The following tables describe the report columns in the Sterling Connect:Direct
Usage by Server Pair Report.
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Column Description

Total Total number (successful and failed) of Processes, Copy steps, Run Job
steps, Run Task steps, and Submit steps for the indicated
PNODE-SNODE combination during the specified time period.

Failed Number of Processes, Copy steps, Run Job steps, Run Task steps, and
Submit steps that completed with a condition code greater than 0 for the
indicated PNODE-SNODE combination during the specified time period.

% Failed Percentage of Processes, Copy steps, Run Job steps, Run Task steps, and
Submit steps that completed with a condition code greater than 0 for the
indicated PNODE-SNODE combination during the specified time period.

Average Time Average time for a Process, Copy step, Run Job step, Run Task step, and
Submit step for the indicated PNODE-SNODE combination during the
specified time period.

Bytes Sent Total number of bytes read from source files for all Copy Steps on the
indicated PNODE-SNODE combination.

Bytes Received Total number of bytes received by destination files for all Copy Steps on
the indicated PNODE-SNODE combination.

Avg Send Rate
(Bytes/Sec)

Average send rate in bytes/second for all Copy Steps on the indicated
PNODE-SNODE combination.

Avg Receive
Rate (Bytes/Sec)

Average receive rate in bytes/second for all Copy Steps on the indicated
PNODE-SNODE combination.

These report columns are displayed on the summary page:

Column Description

Successful Number of Processes, Copy steps, Run Job Steps, Run Task steps, and
Submit steps that completed with a condition code of 0 for the specified
time period. This information is not displayed on the exceptions only
report.

Failed Number of Processes, Copy steps, Run Job Steps that completed with a
condition code greater than 0 for the specified time period.

Total Total number (successful and failed) of Processes, Copy steps, Run Job
Steps, Run Task steps, and Submit steps for the specified time period.
This information is not displayed on the exceptions only report.

Average Time Average time for a Process, Copy step, Run Job Step, Run Task step, and
Submit step for the specified time period. This average includes all
successful and failed Processes and steps. This information is not
displayed on the exceptions only report.

Bytes Sent Total number of bytes read from source files for the specified time
period for all Processes and Copy Steps. This information is not
displayed on the exceptions only report.

Bytes Received Total number of bytes received by destination files for the specified time
period for all Processes and Copy Steps. This information is not
displayed on the exceptions only report.

Avg Send Rate
(Bytes/Sec)

Average send rate in bytes/second for all Processes and Copy Steps.
This information is not displayed on the exceptions only report.

Avg Receive
Rate (Bytes/Sec)

Average receive rate in bytes/second for all Processes and Copy Steps.
This information is not displayed on the exceptions only report.
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Sterling Connect:Direct Usage by Server Pair Report Chart
The Sterling Connect:Direct Usage by Server Pair Report Chart is nearly identical
to the Sterling Connect:Direct Usage by Server Pair Report.

The only difference is that this report displays the following three usage graphs for
each server pair:
v Daily Process and Copy steps
v Daily failed Process and Copy steps
v Daily Copy bytes sent and received

You can select to show all Sterling Connect:Direct activity or exception processing
only. This report is in alphabetic PNODE-SNODE pair order.

The last page of the report summarizes totals and average run time for Processes,
Copy steps, Run Jobs, Run Tasks, and Submit steps, and file transfer information
for the report.

The file name for this report is CD_Charts_Line _ServerPair_ByDay.rpt.

The selection criteria and report columns for this report are the same as the
Sterling Connect:Direct Usage by Server Pair Report.

Sterling Connect:Direct Usage by Server Pair Detail/Summary
Report

The Sterling Connect:Direct Usage by Server Pair Detail/Summary Report shows
Process activity occurring during a specified time period by PNODE-SNODE.

This report is in alphabetic PNODE-SNODE pair order.

You can specify this report to show detail and summary information or summary
information only. You can also select to show all Sterling Connect:Direct activity or
exception processing only.

The last page of the report displays summary report data.

The file name for this report is
CD_Usage_By_ServerPair_and_Exceptions_Summary_Detail.rpt.

The following table lists selection criteria for this report:

Criteria Description

Exceptions Only
(Y/N)

Indicates if the report shows all Sterling Connect:Direct activity or
exception processing only.

Summary_Detail
(S/D)

Indicates if the report shows detail and summary information or
only summary information.

Start Date Start date of the data range.

End Date End date of the data range.

Start Time Start time of the data range. The default is 00:00:00 (midnight).

End Time End time of the data range. The default is 23:59:59.
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The following tables describe the report columns. This table describes columns that
are displayed in the detail report only:

Column Description

Log Date Time Date and time that the statistics record was written to the log file.
Format yyyy/mm/dd hh:mm:ss.msmsms.

Dir Data transfer or command direction.

==> indicates from the PNODE to the SNODE.

<== indicates from the SNODE to the PNODE.

Rec Type Type of statistics record generated. See the documentation for the
appropriate Sterling Connect:Direct platform for a list of record IDs.

Proc Name Sterling Connect:Direct Process name.

Proc Nbr Sterling Connect:Direct Process number.

Step Name Process step.

Duration Amount of time the step took. Format hh:mm:ss.

CC Condition code associated with step termination. Typical codes are:

0=Successful execution.

4=A warning level error was encountered. The statement probably
finished normally, but you should verify the execution results.

8=An error occurred during execution.

16=A catastrophic error occurred during execution.

This report only shows condition codes greater than 0.

Msg ID Server or Sterling Control Center message ID issued with the event.

File Name Name of the transferred file. Depending on the step, this can be either
the source or destination file name.

This table shows columns that are displayed on the summary report and the last
page of the detail report:

Column Description

Successful Number of Processes, Copy steps, Run Job Steps, Run Task steps, and
Submit steps that completed with a condition code of 0 for the specified
time period. This information is not displayed on the exceptions only
report.

Failed Number of Processes, Copy steps, Run Job Steps that completed with a
condition code greater than 0 for the specified time period.

Total Total number (successful and failed) of Processes, Copy steps, Run Job
Steps, Run Task steps, and Submit steps for the specified time period.
This information is not displayed on the exceptions only report.

Average Time Average time for a Process, Copy step, Run Job Step, Run Task step, and
Submit step for the specified time period. This average includes all
successful and failed Processes and steps. This information is not
displayed on the exceptions only report.

Bytes Sent Total number of bytes read from source files for the specified time
period for all Processes and Copy Steps. This information is not
displayed on the exceptions only report.
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Column Description

Bytes Received Total number of bytes received by destination files for the specified time
period for all Processes and Copy Steps. This information is not
displayed on the exceptions only report.

Avg Send Rate
(Bytes/Sec)

Average send rate in bytes/second for all Processes and Copy Steps.
This information is not displayed on the exceptions only report.

Avg Receive
Rate (Bytes/Sec)

Average receive rate in bytes/second for all Processes and Copy Steps.
This information is not displayed on the exceptions only report.
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Chapter 5. Data for third-party reporting tools

Data for third-party reporting tools is contained in Sterling Control Center tables.
The following tables are discussed here:

Note: Some fields use a Java epoch timestamp as a unique value. This timestamp
is the number of milliseconds that have elapsed since January 1, 1970.

Events table (EVENTS)
Sterling Control Center reports contain a variety of data fields from the Events
table.

Element Type Description

ACTION_ID varchar Name of an action called by a rule.

ACTIONS_COMPLETED bigint Indicates if the Sterling Control Center actions are completed. The
values are:

Null=Actions not completed

Timestamp=Actions completed

This element is used for restarts.

ALERT char Indicates if an alert was triggered. The values are:

Null=No alert

0-3=Alert severity

ALERT_DELETED char Indicates if the alert was deleted. The values are:

Null=Alert not deleted

Y=Alert deleted

ALERT_DELETED_BY varchar Sterling Control Center user name of the person who removed the
alert. If the alert was deleted by a rule, this field will contain
“unknown.”

ALERT_DESC varchar Comments entered by the user when the alert was deleted.

ALERT_UPD_TIME bigint Time that the alert was updated, in Java epoch timestamp format (that
is, the number of milliseconds that have elapsed since January 1, 1970).

DATE_TIME varchar Date and time that the event was generated. Format yyyy/mm/dd
hh:mm:ss.msmsms.

DEST_FILE varchar Destination file name in a copy operation.

EMAIL_FLAG bigint This field is used by Sterling Control Center for recover purposes.
When a rule matches an event, the associated action is executed. If the
action includes sending an e-mail, this flag updates after the e-mail is
sent. Reporting on this field is not recommended. The values are:

0=No e-mail sent

>0=E-mail sent

The value is set to zero if nothing was done, but is set to the
Timestamp if something was done.
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Element Type Description

EVENT_ID bigint ID number assigned by the system to each event.

EVENT_TYPE bigint Code indicating the type of event.

FILE_SIZE bigint Size of the file transferred by the Sterling Connect:Direct Process or
Sterling Connect:Enterprise batch.

FROM_NODE varchar Server that sent the file.

P=Pnode was sending server.

S=Snode was sending server.

MSG_ID varchar Server or Sterling Control Center message ID issued with the event.

NODE_ID varchar Server name of alias.

NODE_TYPE varchar Code indicating the type of server. The server types are:

0=Sterling Control Center

1=Sterling Connect:Direct

2=Sterling Connect:Enterprise

3=Sterling B2B Integrator

4=FTP Server

5=Sterling Connect:Express

6=QuickFile

7=MQ MFT

ORIG_NODE varchar The server that initiated the Process.

PART_KEY date The date the event was generated. The format is yyyy-mm-dd.

PERCENT_COMPLETE bigint Percentage of a Sterling Connect:Direct Copy Process that is complete.

PROC_ID varchar Sterling Connect:Direct Process or Sterling Connect:Enterprise batch
number.

PROC_NAME varchar Sterling Connect:Direct Process name or Sterling Connect:Enterprise
batch name.

REMOTE_NODE varchar Name of the remote server involved in the Process or file transfer.

RET_CODE varchar Specifies a numeric code returned from a completed Process or file
transfer that indicates failure or success. The standard return codes are:

0=Successful completion

4=Warning

8=Error

16=Catastrophic error

RULE_ID varchar Name of the rule triggered by the event.

RULE_INSTANCE_ID bigint Unique identifier for rule matching instances

SEQ_NUM bigint A number used to uniquely identify events generated at the same time.

SHORT_MSG varchar Message text associated with the Message ID.
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SLC_FLAG bigint Internally used by Sterling Control Center for recovery purposes. When
an event is generated, it is sent to the SLC subsystem. This flag
indicates whether or not the event has been sent to that subsystem.
Reporting on this field is not recommended. The values are:

0=Event was not sent

>0=Event was sent

SLC_ID text System-assigned name for each SLC window.

SLC_INSTANCE_ID bigint Unique identifier for each SLC window.

SLC_SOURCE_1 text Internal field used for SLC recovery.

SLC_SOURCE_2 text Internal field used for SLC recovery.

SLC_SRC_EVENT_ID bigint EVENT_ID of the event that triggered the SLC.

SOURCE_FILE varchar Source file name in a copy.

STEP_NAME varchar Name of the Sterling Connect:Direct Process step.

SUBMITTER varchar User ID of the Process submitter.

TRAP_FLAG bigint Internally used by Sterling Control Center for recovery purposes. When
a rule matches an event, the associated action is executed. If the action
includes sending an SNMP trap, this flag updates after the SNMP trap
is sent. Reporting on this field is not recommended. The values are:

0=No trap generated

>0=Trap generated

The value is set to zero if nothing was done, but is set to the
Timestamp if something was done.

USER_DATA_1 varchar User metadata field 1.

USER_DATA_2 varchar User metadata field 2.

USER_DATA_3 varchar User metadata field 3.

USER_DATA_4 varchar User metadata field 4.

SERVER_DATA_1 varchar Server metadata field 1.

SERVER_DATA_2 varchar Server metadata field 2.

SERVER_DATA_3 varchar Server metadata field 3.

SERVER_DATA_4 varchar Server metadata field 4.

SERVER_DATA_5 varchar Server metadata field 5.

SERVER_DATA_6 varchar Server metadata field 6.

SERVER_DATA_7 varchar Server metadata field 7.

SERVER_DATA_8 varchar Server metadata field 8.

SERVER_DATA_9 varchar Server metadata field 9.

SERVER_DATA_10 varchar Server metadata field 10.
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USER_OP_FLAG bigint Internally used by Sterling Control Center for recovery purposes. When
a rule matches an event, the associated action is executed. If the action
includes invoking an OS command script, this flag is updated after
invoking the OS command script. Reporting on this field is not
recommended. The values are:

0=No OS command invoked

>0=OS command invoked

The value is set to zero if nothing was done, but is set to the
Timestamp if something was done.

XML_STRING text An XML representation of the event.

Events extension table (EVENTS_EXT)
The Events Extension (EVENTS_EXT) database table is used when an event
triggers one or more Data Visibility Group (DVG) rules. For each DVG rule an
event triggers, a supplemental entry, or row, is inserted into the EVENTS_EXT
table and the EVENT_ID value is used to join the information in the two tables.

The following table describes the data fields available from the EVENTS_EXT table
for Sterling Control Center reports.

Element Type Description

ACTION_ID varchar Name of an action called by a rule.

ACTIONS_COMPLETED bigint Indicates if the Sterling Control Center actions are completed. The
values are:

Null=Actions not completed

Timestamp=Actions completed

This element is used for restarts.

ALERT char Indicates if an alert was triggered. The values are:

Null=No alert

0-3=Alert severity

ALERT_DELETED char Indicates if the alert was deleted. The values are:

Null=Alert not deleted

Y=Alert deleted

ALERT_DELETED_BY varchar Sterling Control Center user name of the person who removed the
alert. If the alert was deleted by a rule, this field will contain
“unknown.”

ALERT_UPD_TIME bigint Time that the alert was updated, in Java epoch timestamp format (that
is, the number of milliseconds that have elapsed since January 1, 1970).

DATE_TIME varchar Date and time that the event was generated. Format yyyy/mm/dd
hh:mm:ss.msmsms.

DVG varchar Data visibility group for this event.

56 Sterling Control Center: Reports Guide



Element Type Description

EMAIL_FLAG bigint This field is used by Sterling Control Center for recovery purposes.
When a rule matches an event, the associated action is executed. If the
action includes sending an e-mail, this flag updates after the e-mail is
sent. Reporting on this field is not recommended. The values are:

0=No e-mail sent

>0=E-mail sent

The value is set to zero if nothing was done, but is set to the
Timestamp if something was done.

EVENT_ID bigint ID number assigned by the system to each event. The EVENT_ID value
can be used to find additional information associated with this event in
the Events database table.

PART_KEY date The date the event was generated. The format is yyyy-mm-dd.

RULE_ID varchar Name of the rule triggered by the event.

RULE_INSTANCE_ID bigint Unique identifier for rule matching instances

TRAP_FLAG bigint Internally used by Sterling Control Center for recovery purposes. When
a rule matches an event, the associated action is executed. If the action
includes sending an SNMP trap, this flag updates after the SNMP trap
is sent. Reporting on this field is not recommended. The values are:

0=No trap generated

>0=Trap generated

The value is set to zero if nothing was done, but is set to the
Timestamp if something was done.

USER_OP_FLAG bigint Internally used by Sterling Control Center for recovery purposes. When
a rule matches an event, the associated action is executed. If the action
includes invoking an OS command script, this flag is updated after
invoking the OS command script. Reporting on this field is not
recommended. The values are:

0=No OS command invoked

>0=OS command invoked

The value is set to zero if nothing was done, but is set to the
Timestamp if something was done.

Event comments table (EVENT_COMMENTS)
The Event comments table stores comment information on alerts when those alerts
are deleted. In earlier versions of Sterling Control Center these comments were
part of the Events table.

The following table describes the data fields in the Event comments table for
Sterling Control Center reports:

Element Type Description

DATE_TIME varchar The event date and time.

EVENT_COMMENT text Textual comment describing the event's deletion.

EVENT_ID bigint The identifier for the specific event.
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PART_KEY date The date the event was generated. The format is yyyy-mm-dd.

USER_ID varchar The identifier of the Sterling Control Center user entering the comment
and deleting the event.

Sterling Connect:Direct statistics table (V_CD_STATS_LOG)
The following table describes the data fields available from the Sterling
Connect:Direct Virtual Statistics (V_CD_STATS_LOG) table for Sterling Control
Center reports:

Element Type Description

ALIAS_MEMBER_NAME varchar PDS alias member name.

BYTES_READ bigint Number of bytes read from the source file.

BYTES_RECEIVED bigint Number of bytes received by the destination file.

BYTES_SENT bigint Number of bytes sent to the destination file.

BYTES_WRITTEN bigint Number of bytes written to the destination file.

CB_ENC_ALG varchar Specifies the name of the encryption algorithm.

CC_NAME varchar Not completed.

CERT_ISSUER text Issuer value from certificate used.

CERT_SUBJECT text Subject name value from certificate used.

CHECK_POINT varchar Indicates whether Checkpoint is activated for this Process.

Y=Checkpoint is activated

N=Checkpoint is not activated

CIPHER_SUITE text Name of cipher suite used.

CLASS varchar Determines the server-to-server session on which a Process can
be executed.

COND_CODE varchar Return code that is associated with step termination. Typical
codes are:

0=Successful execution.

4=A warning level error was encountered. The statement
probably finished normally, but verify the execution results.

8=An error occurred during execution.

16=A unrecoverable error occurred during execution.
Note: This column is not populated in this table since it is
duplicated in the Events table.

DATE_TIME varchar Date and time that the event was generated in UTC. The format
is yyyy/mm/dd hh:mm:ss.msmsms.

DEBUG varchar For Sterling Connect:Direct for z/OS®, the DEBUG setting within
the Process.
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DEST_DISP_1 varchar What to do with the destination file after a copy is complete. The
values are:

NEW=Creates a file on the destination node.

RPL=Creates a file on the destination node or, if the file exists,
replaces the named file on the destination node.

MOD=Appends data to the end of an existing file for which you
have exclusive rights.

DEST_DISP_2 varchar Disposition of the destination file after a normal Process step
termination. The values are:

C=catalog

K=Keep

DEST_DISP_3 varchar Disposition of the destination file after an abnormal Process step
termination.

C=catalog

D=Delete

K=Keep

DEST_FILE varchar Destination file name.
Note: This column is not populated in this table since it is
duplicated in the Events table.

EVENT_ID bigint ID number that is assigned by the system to each event.

EXEC_PRIORITY varchar Priority under which the operating system thread that executes
Sterling Connect:Direct runs. Applies to Microsoft Windows only.

EXT_COMPRESSION varchar Extended compression option.

Y=Extended compression is activated

N=Extended compression is not activated

FEED_BACK varchar Feedback code for the module. The value depends on the
module that creates it. Your IBM Support representative might
ask for this value.

FROM_NODE varchar Node that sent the file. The values are:

S=SNODE

P=PNODE
Note: This column is not populated in this table since it is
duplicated in the Events table.

FUNCTION_INFO varchar Specifies the function that is performed.
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HOLD varchar Hold status of a Process. The Hold statuses are:

No=The Process is not placed in the Hold queue. It is run as
soon as resources are available.

Yes=The Process is held in the Hold queue in Held Initially (HI)
status until it is explicitly released.

Call=The Process is held until the SNODE, as specified in the
Process SNODE parameter, connects to the PNODE. The Process
is then released for execution. The Process is also released when
another Process on the PNODE connects to the SNODE.

LINK_FAIL varchar Indicated whether a link failure occurred during transmission.

v Link fail occurred

v Link fail did not occur

LOCAL_COND_CODE varchar Condition (return) code that is produced by the local server. See
COND_CODE description for typical return codes.

LOCAL_MSG_ID varchar Specifies the message ID produced by the local server.

LOCAL_NODE varchar Server that processed the file.

S=SNODE

P=PNODE

LOG_DATE_TIME varchar Date and time that the statistics record is written to the log file.
Format yyyy/mm/dd hh:mm:ss.msmsms.

MEMBER_NAME varchar Name of the member copied.

MERGE_EA varchar Specifies the merged data encryption algorithm resulting from
the merger of the PNODE and SNODE encryption algorithms.

MERGE_SIGN varchar Specifies the merged results from the digital signature settings
for the PNODE and SNODE. If digital signature is enabled for
either the PNODE or the SNODE, then digital signatures are
used for the session. If digital signatures are not enabled for both
the PNODE and SNODE, digital signatures are not used.

MSG_ID varchar Server or Sterling Control Center message ID issued with the
event.
Note: This column is not populated in this table since it is
duplicated in the Events table.

MSG_SHORT_TXT varchar Message short text.
Note: This column is not populated in this table since it is
duplicated in the Events table.

NODE_ID varchar Server alias.
Note: This column is not populated in this table since it is
duplicated in the Events table.

NODE_NAME varchar Name of the Sterling Connect:Direct server.

NODE_TYPE varchar Code indicating the type of server.
Note: This column is not populated in this table since it is
duplicated in the Events table.

OTHER_COND_CODE varchar Condition (return) code that is produced by the other (remote)
server. See COND_CODE description for typical return codes.

OTHER_MSG_ID varchar Specifies the message ID produced by the other (remote) server.

PART_KEY date The date the statistics record is written to the log file. The format
is yyyy-mm-dd.
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PNODE varchar Primary node name.
Note: This column is not populated in this table since it is
duplicated in the Events table.

PNODE_ACCT_INFO varchar PNODE accounting information.

PNODE_ENC_ALG_LIST varchar Data encryption algorithm that is used on the PNODE.

PNODE_ENC_DATA varchar PNODE encryption data.

PNODE_PLEX_CLASS varchar PLEXCLASS of the PNODE.

PNODE_SIGN varchar Specifies whether signatures are enabled for the PNODE.

PREV_SIGN_VERIFIED varchar Specifies whether the previous encryption key is used for
verifying the digital signature.

PRIORITY varchar Specifies the priority that is assigned to the Process. The lower
the number the higher the priority.

PROC_NAME varchar Sterling Connect:Direct Process name.
Note: This column is not populated in this table since it is
duplicated in the Events table.

PROC_NUMBER varchar Sterling Connect:Direct Process number.
Note: This column is not populated in this table since it is
duplicated in the Events table.

QUEUE varchar Specifies the queue that contains the Process. The queues are:

Execution=Processes currently runing.

Hold=Processes that are either held by the user or operator or
held because of execution errors.

Timer=Processes that are scheduled to be run later, or Processes
in time retry because of session errors.

Wait=Processes that are eligible for execution and are awaiting
selection.

RECORD_CATEGORY varchar Specifies whether the record is related to an event or to a
Process. The values are:

CAEV=The record is related to a Sterling Connect:Direct event,
such as a Sterling Connect:Direct shutdown.

CAPR=The record is related to a Sterling Connect:Direct Process.

RECORD_ID varchar Type of statistics record generated. See the Event Type
Descriptions Help topic for a list of record IDs.

RECORDS_READ bigint Specifies the number of records that are read from the source
file.

RECORDS_WRITTEN bigint Specifies the number of records that are written to the
destination file.

RESTART varchar Indicates whether Restart is activated for the Process.

Y=Restart is activated

N=Restart is not activated
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RETAIN varchar Indicates whether Sterling Connect:Direct retains a copy of a
Process after it runs. The Retain options are:

Initial=Specifies to retain the Process in the Hold queue for
execution every time that Sterling Connect:Direct initializes.

No=Specifies not to retain the Process after it is run.

Yes=Specifies to retain the Process in the Hold queue after it is
run. You can release the Process for execution later or delete it.

RU_SIZE varchar Specifies the size of buffers that are received by the destination
file.

RUS_RECEIVED bigint Specifies the number of buffers that are received by the
destination file.

RUS_SENT bigint Specifies the number of buffers that are sent to the destination
file.

SCH_DATE_TIME varchar Specifies the date and time that a Process is scheduled to run.
Format yyyy/mm/dd hh:mm:ss.msmsms.

SECURE_ENABLED varchar Indicates that Sterling Connect:Direct Secure Plus is activated for
the Process.

SECURE_PROTOCOL text Name of protocol that is used for secure connection.

SEQ_NUM bigint System-assigned sequence number.
Note: This column is not populated in this table since it is
duplicated in the Events table.

SERVER_NAME varchar Sterling Connect:Direct/Plex server name.

SNODE varchar Secondary node name.
Note: This column is not populated in this table since it is
duplicated in the Events table.

SNODE_ACCT_INFO varchar Specifies SNODE accounting information.

SNODE_ENC_ALG_LIST varchar Data encryption algorithm that is used on the SNODE.

SNODE_ENC_DATA varchar SNODE encryption data.

SNODE_PLEX_CLASS varchar PLEXCLASS of the SNODE.

SNODE_SIGN varchar Specifies whether digital signatures are enabled for the SNODE.

SOURCE_MEMBER_NAME varchar Source file member name.

SRC_DISP_1 varchar Specifies access to the source file during a copy operation. The
source disposition values are:

SHR=The file can be opened by another Process for read-only
access while it is being copied.

OLD=The file cannot be opened by another Process during the
transfer.

SRC_DISP_2 varchar Disposition of the source file after a successful Process step
termination.

SRC_DISP_3 varchar Disposition of the source file after an abnormal Process step
termination.

SRC_FILE varchar Source file name.
Note: This column is not populated in this table since it is
duplicated in the Events table.

START_TIME varchar Process start time.
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STATUS varchar Specifies the Process status. The statuses are:

Execution (EX)=The Process is running.

Pending Execution (PE)=The Process is selected for execution
and startup is in progress.

Waiting Connection (WC)=The Process is ready to run, but all
available connections to the SNODE are in use.

Waiting Start Time (WS)=The Process is waiting in the Timer
queue because it is submitted with a start time or date that has
not expired. When the start time is reached, the Process is placed
into the Wait queue for scheduling for execution.

Held Suspension (HS)=The operator issued a delete Process
request with Hold set to Yes.

Timer Retry (RE)=A Process error occurred and the Process is
moved to the Timer queue in RE status with short-term and
long-term wait times beginning.

Held for Call (HC)=The Process is submitted with the Hold
parameter that is set to Call. A session started from either node
moves the Process to the Wait queue in WC status. The Process
is placed in the Execution queue when it is selected for
execution.

Held Due to Error (HE)=A session error or other abnormal
condition occurred.

Held Initially (HI)=The Process is submitted with the Hold
option that is set to Yes.

Held By Operator (HO)=A change Process request with Hold set
to Yes was issued.

Held By Retain (HR)=The Process was submitted with retain
after execution set to Yes or Initial.

STD_COMPRESSION varchar Standard compression option.

Y=Standard compression is activated

N=Standard compression is not activated

STEP_NAME varchar Process step name.
Note: This column is not populated in this table since it is
duplicated in the Events table.

STOP_TIME varchar Process stop time.

SUB_DATE_TIME varchar Date and time that the Process was submitted. Format
yyyy/mm/dd hh:mm:ss.msmsms.

SUBMIT_NODE varchar Server where the submit operation was performed.

SUBMITER varchar User ID that submitted the Process.
Note: This column is not populated in this table since it is
duplicated in the Events table.

SUBMITTER_NODE varchar Server that submitted the Process.

SUR_SIGN_VERIFIED varchar Specifies whether the current encryption key was used for
verifying the digital signature.
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SYS_OPTS varchar Specifies the platform-specific system operations.

TARGET_MEMBER_NAME varchar Destination target member name.

TRANSLATION varchar Specifies whether the data was translated.

Y=Data was translated

N=Data was not translated

USER_DATA_1 varchar Metadata field 1.
Note: This column is not populated in this table since it is
duplicated in the Events table.

USER_DATA_2 varchar Metadata field 2.
Note: This column is not populated in this table since it is
duplicated in the Events table.

USER_DATA_3 varchar Metadata field 3.
Note: This column is not populated in this table since it is
duplicated in the Events table.

USER_DATA_4 varchar Metadata field 4.
Note: This column is not populated in this table since it is
duplicated in the Events table.

Sterling Connect:Direct statistics table By record ID
The following table shows the columns filled in for each Record ID in the Virtual
Sterling Connect:Direct Statistics Table (V_CD_STATS_LOG). These record IDs are
for Sterling Connect:Direct for z/OS only.

Record ID SI CH QE SB PI ZI CI CT PT ZT MC

ALIAS_MEMBER_NAME X

BYTES_READ X

BYTES_SENT X

CERT_ISSUER X X

CERT_SUBJECT X X

CHECK_POINT X

CIPHER_SUITE X X

COND_CODE X X X X X X X X X

DEST_DISP_1 X

DEST_DISP_2 X

DEST_DISP_3 X

DEST_FILE X

EVENT_ID X X X X X X X X X X

FEED_BACK X

FROM_NODE X X

LOCAL_NODE X X

LOG_DATE_TIME X X X X X X X X X X

MEMBER_NAME X X X

MSG_ID X X X X X
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MSG_SHORT_TXT X X X X X

NODE_ID X X X X X X X X X X

NODE_NAME X X X X X X X X X X

NODE_TYPE X X X X X X X X X X

OTHER_COND_CODE X

OTHER_MSG_ID X

PNODE X X X X X X X X

PNODE_ACCT_INFO X

PNODE_ENC_ALG_LIST X

PNODE_PLEX_CLASS X

PNODE_SIGN X

PRIORITY X

PROC_NAME X X X X X X X X X

PROC_NUMBER X X X X X X X X X

QUEUE X

RECORD_ID X X X X X X X X X X X

RECORDS_READ X

RESTART X

RETAIN X X X X X X X X

RU_SIZE X

RUS_RECEIVED X

RUS_SENT X

SCH_DATE_TIME X X

SECURE_ENABLED X X

SECURE_PROTOCOL X X

SEQ_NUM X X X X X X X X X X

SERVER_NAME X X X X X X X

SNODE X X X X X X X X

SNODE_ACCT_INFO X

SNODE_ENC_ALG_LIST X

SNODE_PLEX_CLASS X

SNODE_SIGN X

SOURCE_MEMBER_NAME X

SRC_DISP_1 X

SRC_DISP_2 X

SRC_DISP_3 X

SRC_FILE X X

START_TIME X X X X X X X X X

STATUS X

STD_COMPRESSION X

STEP_NAME X X X
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STOP_TIME X X

SUB_DATE_TIME X X X X

SUBMIT_NODE X X X X X X X X X

SUBMITER X X X X X X X X X

TARGET_MEMBER_NAME X X X

USER_DATA_1 X X X X X X X X X X X

USER_DATA_2 X X X X X X X X X X X

USER_DATA_3 X X X X X X X X X X X

USER_DATA_4 X X X X X X X X X X X

Sterling Connect:Enterprise statistics table (V_CE_STATS_LOG)
The following table describes the data fields available from the Sterling
Connect:Enterprise Virtual Statistics (V_CE_STATS_LOG) table for Sterling Control
Center reports:

Element Type Description

APPL_AGENT_TYPE varchar Specifies one of the following application agent types:

v Console

v End Of Batch

v Logging

v Scheduler

v Wake Up Terminate

BATCH_ID varchar User-assigned description of a Sterling Connect:Enterprise batch.
Note: This column is not populated in this table since it is
duplicated in the Events table.

BATCH_NUMBER varchar System-assigned number for each batch in a Sterling
Connect:Enterprise repository.
Note: This column is not populated in this table since it is
duplicated in the Events table.

BYTES_READ bigint Number of bytes read from the source file.

BYTES_WRITTEN bigint Number of bytes written to the destination file.

CC_NAME varchar Not filled in.

DEST_FILE varchar Destination file name.
Note: This column is not populated in this table since it is
duplicated in the Events table.

EVENT_ID bigint ID number assigned by the system to each event.

JOB_ID varchar Batch job identifier.

JOB_NAME varchar Name of the job that added the batch.

LINE_NAME varchar Line accessed during Auto and Remote Connects.

LIST_NAME varchar Sterling Connect:Enterprise Auto Connect List Name. The Auto
Connect List defines the remote sites that the Sterling
Connect:Enterprise server automatically connects to and transmits
batches to.

LOG_DATE_TIME varchar Date and time that the statistics record was written to the log file.
Format yyyy/mm/dd hh:mm:ss.msmsms.
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MAILBOX_FLAGS varchar Sterling Connect:Enterprise batch status flag. See the appropriate
Sterling Connect:Enterprise documentation for a list of batch status
flags.

MAILBOX_ID varchar Specifies the repository associated with the Sterling
Connect:Enterprise batch

MSG_ID varchar Server or Sterling Control Center message ID issued with the event.
Note: This column is not populated in this table since it is
duplicated in the Events table.

MSG_SHORT_TXT varchar Message short text.
Note: This column is not populated in this table since it is
duplicated in the Events table.

NODE_ID varchar Server alias.
Note: This column is not populated in this table since it is
duplicated in the Events table.

NODE_NAME varchar Name of the Sterling Connect:Direct server.

NODE_TYPE varchar Code indicating the type of server.
Note: This column is not populated in this table since it is
duplicated in the Events table.

OID varchar Object identifier that identifies the Sterling Connect:Enterprise
SNMP trap received by the engine.

PROTOCOL varchar Protocol used for the file transfer.

RECIP_MAILBOX_ID varchar Sterling Connect:Enterprise Mailbox ID of the repository that
received the batch.

RECORD_CATEGORY varchar One of the following connection types:

AC=Auto Connect

RC=Remote Connect

RECORD_ID varchar Type of statistics record generated. See the Event Type Descriptions
Help topic for a list of record IDs.

REL_SELECT_STMT varchar Position of the Sterling Connect:Enterprise SELECT statement that
executed the rule which caused an SNMP trap to be generated.

REMOTE_NAME varchar Name of the remote server involved in the file transfer.

RULE_MEMBER_NAME varchar Data set member name that contains the application agent rules.

RULE_NAME varchar Name of the Sterling Connect:Enterprise application agent rule.

SEQ_NUM bigint System-assigned sequence number.
Note: This column is not populated in this table since it is
duplicated in the Events table.

SESSION_ID varchar System-assigned ID identifying a connection between a Sterling
Connect:Enterprise host and a remote site.

SRC_FILE varchar Source file name.
Note: This column is not populated in this table since it is
duplicated in the Events table.

START_TIME varchar Time that start-of-batch transmission information is received by the
Sterling Control Center engine.

STATUS varchar FTP session status (active or inactive).
Note: This column is not populated in this table since it is
duplicated in the Events table.

STOP_TIME varchar Time that end-of-batch transmission information is received by the
Sterling Control Center engine.
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TIME_UP varchar Length of time that the Sterling Connect:Enterprise server has been
running.

USER_DATA_1 varchar Metadata field 1.
Note: This column is not populated in this table since it is
duplicated in the Events table.

USER_DATA_2 varchar Metadata field 2.
Note: This column is not populated in this table since it is
duplicated in the Events table.

USER_DATA_3 varchar Metadata field 3.
Note: This column is not populated in this table since it is
duplicated in the Events table.

USER_DATA_4 varchar Metadata field 4.
Note: This column is not populated in this table since it is
duplicated in the Events table.

WKFLOW_ID varchar Sterling B2B Integrator ID, if Sterling B2B Integrator requested a file
transfer from a Sterling Connect:Enterprise for UNIX server.

WRKFLOW_URL varchar Sterling B2B Integrator URL, if Sterling B2B Integrator requested a
file transfer from a Sterling Connect:Enterprise for UNIX server.

Sterling Connect:Express virtual statistics table (V_CX_STATS_LOG)
The following table describes the data fields available from the Sterling
Connect:Express Virtual Statistics (V_CX_STATS_LOG) table for Sterling Control
Center reports:

Element Type Description

BEG_XFER_DATE varchar Beginning of transfer date time. The
format is yyyy/mm/ddhh:mm:ss

CC_NAME varchar Not filled in.

CX_EVENT_TYPE varchar Event type. Values may be:

v ConnectionError

v ConnectionShutdownStarted

v ConnectionStarted

v NodeCommand

v NodeError

v NodeLicense

v NodeStarted

v NodeStatus

v NodeShutdown

v ProcessEnded

v ProcessStarted

v ProcessStepEnd

v ProcessStepProgress

v ProcessStepStart

v TimerEvent

CX_RET_CODE varchar Return code.
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DATE_TIME varchar Date and time that the event was
generated in UTC. The format is
yyyy/mm/dd hh:mm:ss.msmsms.

DEST_FILE varchar Destination file name in a copy
operation.

END_XFER_DATE varchar End of transfer date/time.

The format is yyyy/mm/ddhh:mm:ss

EVENT_ID bigint ID number assigned by the system to
each event.

EVENT_TYPE bigint Code indicating the type of event.

FILE_BYTES bigint File bytes transferred.

FILE_LABEL varchar File label (PeSIT pi37).

FILE_NAME varchar Name of file transferred.

FILE_RECEIVER varchar Receiver of the file.

FILE_SENDER varchar Sender of the file.

FILE_SIZE bigint Size of file transferred.

FROM_NODE varchar Server that sent the file.

P=Pnode was sending server.

S=Snode was sending server.

LINK_TYPE varchar Type of link. The values are:

v T=TCPIP

v S=SNA

LOCAL_FILE_NAME varchar Local file name.

LOCAL_NODE_NAME varchar Local node name.

MSG_ID varchar Server message ID issued with the
event.

NET_RET_CODE varchar Network return code.

NETWORK_BYTES bigint Network bytes transferred

NODE_ID varchar Server name alias.

NODE_NAME varchar Server name.

NODE_TYPE varchar Code indicating the type of server.
The server types are:

v 0=Sterling Control Center

v 1=Sterling Connect:Direct

v 2=Sterling Connect:Enterprise

v 3=Sterling B2B Integrator

v 4=FTP Server

v 5=Sterling Connect:Express

v 6=QuickFile

v 7=MQ MFT

OPERATING_SYSTEM varchar Operating system.

ORIG_NODE varchar The server that initiated the Process.

OTHER_NODE_NAME varchar Other node name.
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PROC_ID varchar Process/Request number.

PROC_NAME varchar Sterling Connect:Express Process
name.

PROC_ORIGINATOR varchar Process Originator. The values are:

v I=Local node is the originator.

v E=Remote node is the originator.

PROT_RET_CODE varchar Protocol return code

RECORD_DATE varchar Record date. The format is
yyyy/mm/dd hh:mm:ss.msmsms.

RECORDS bigint Number of records transferred

REMOTE_NODE varchar Name of the remote server involved
in the file transfer.

REQUEST_NUMBER varchar Request number.

RET_CODE varchar The system return code derived from
the CX_RET_CODE,
PROT_RET_CODE, and
SYS_RET_CODE. If any of these
elements are set, RET_CODE will be
set.

SEQ_NUM bigint A number used to uniquely identify
events generated at the same time.

SHORT_MSG varchar Message text associated with the
Message ID.

SOURCE_FILE varchar Source file name in a copy.

SUBMITTER varchar User ID of the process submitter.

SYS_RET_CODE varchar System return code.

TRANSFER_DIR varchar Transfer direction. Values are:

v T=Transmit

v R=Receive. If the value is R, the
local node is receiving.

TYPE_REQUEST varchar Request type. Values are:

v N=Normal request submitted from
pnode to snode to send or receive
a file.

v H=Hold request prepared by the
snode for future transmission.

v I=Inquiry submitted by the pnode
for reception of a file that has been
made available by a corresponding
Hold request on the snode.

v M=Message

v E= End to end response

USER_DATA_1 varchar User metadata field 1.

USER_DATA_2 varchar User metadata field 2.

USER_DATA_3 varchar User metadata field 3.

USER_DATA_4 varchar User metadata field 4.
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USER_DATA_RCVD varchar User data received (PeSIT pi99),
associated to file.

USER_DATA_SENT varchar User data sent (PeSIT pi99),
associated to file.

UTCOFFSET bigint UTC offset when event transpired.

XFER_DEST varchar Transfer destination

XFER_ID varchar Transfer identifier

XFER_ORIGIN varchar Transfer origin

XFER_PROTOCOL varchar File transfer protocol. Values are:

v A=PeSIT E "PROF=ANY"

v E=PeSIT Type E

v D=PeSIT Type D

v F=FTP

v O=Odette

v A=Compatible with PeSIT

QuickFile statistics table (QF_STATS_LOG)
The following table describes the data fields available from the QuickFile statistics
table (QF_STATS_LOG) for Sterling Control Center reports:

Element Type Description

EVENT_ID bigint ID number assigned by the system to
each event.

FILE_NAME varchar The name of the file uploaded or
downloaded associated with the
statistic.

LOG_DATE_TIME varchar Date and time the statistics record
was generated. The format is
yyyy/mmdd hh:mm:ss.msmsms

OPERATION varchar The operation value associated with
the statistic. Possible values include,
but are not limited to: Logout, Policy
updated, AFT Enabled, Downloaded,
Sent

PART_KEY date The date in the statistics record was
generated. The format is
yyyy-mm-dd

PKG_FILE_COUNT bigint Total number of files in the package
uploaded. Value set to -1 when event
has no value for this field.

PKG_ID varchar The package identifier.

PKG_SUBJECT varchar The package subject value.

PKG_TOT_SIZE bigint Total size of all files in the package
uploaded. Value set to -1 when event
has no value for this field.

QF_EVENT_TYPE varchar Event type associated with the
statistic.
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RECP_USER_EMAIL varchar Recipient user email address.

RECP_USER_FNAME varchar Recipient user full name.

RECP_USER_ID varchar Recipient user ID.

RECP_USER_REG varchar Recipient user registered. Value,
when set, will be "true" or "false".

SERVER_NAME varchar Server name reported by QuickFile
server.

SERVER_OS varchar Operation system value reported by
QuickFile server.

SERVER_VERSION varchar Version value reported by QuickFile
server.

STATUS_CODE varchar Status code for the operation
performed.

USER_EMAIL varchar User email address.

USER_FNAME varchar User full name.

USER_ID varchar User ID.

USER_REG varchar User registered. Value, when set, will
be "true" or "false".

UTC_OFFSET bigint The delta, in seconds, from Universal
Coordinated time for the recorded
LOG_DATE_TIME value.

FILE_SIZE bigint Size of file. Value set to -1 when
event has no value for this field.

QuickFile virtual statistics table (V_QF_STATS_LOG)
The following table describes the data fields available from the QuickFile Virtual
Statistics (V_QF_STATS_LOG) table for Sterling Control Center reports:

Element Type Description

CC_NAME varchar Not filled in.

EVENT_ID bigint ID number assigned by the system to
each event.

DATE_TIME varchar Date and time that the event was
generated in UTC. The format is
yyyy/mm/dd hh:mm:ss.msmsms.

DEST_FILE varchar Destination file name in a copy
operation.

EVENT_TYPE bigint Code indicating the type of event.

FILE_NAME varchar The name of the file uploaded or
downloaded associated with the
statistic.

FROM_NODE varchar Server that sent the file.

LOG_DATE_TIME varchar Date and time the statistics record
was generated. The format is
yyyy/mmdd hh:mm:ss.msmsms
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MSG_ID varchar Server message ID issued with the
event.

NODE_ID varchar Server name alias.

NODE_TYPE varchar Code indicating the type of server.
The server types are:
0=Sterling Control Center
1=Sterling Connect:Direct
2=Sterling Connect:Enterprise
3=Sterling B2B Integrator
4=FTP Server
5=Sterling Connect:Express
6=QuickFile
7=MQ MFT

OPERATION varchar The operation value associated with
the statistic. Possible values include,
but are not limited to: Logout, Policy
updated, AFT Enabled, Downloaded,
Sent

ORIG_NODE varchar The server that initiated the Process.

PKG_FILE_COUNT bigint Total number of files in the package
uploaded. Value set to -1 when event
has no value for this field.

PKG_ID varchar The package identifier.

PKG_SUBJECT varchar The package subject value.

PKG_TOT_SIZE bigint Total size of all files in the package
uploaded. Value set to -1 when event
has no value for this field.

PROC_NAME varchar QuickFile Process name.

QF_EVENT_TYPE varchar Event type associated with the
statistic.

RECP_USER_EMAIL varchar Recipient user email address.

RECP_USER_FNAME varchar Recipient user full name.

RECP_USER_REG varchar Recipient user registered. Value,
when set, will be "true" or "false".

REMOTE_NODE varchar Name of the remote server involved
in the file transfer.

RET_CODE varchar Specifies a numeric code returned
from a completed Process or file
transfer that indicates failure or
success. The standard return codes
are:

0=Successful completion
4=Warning
8=Error
16=Catastrophic error

SERVER_NAME varchar Server name reported by QuickFile
server.

SERVER_OS varchar Operation system value reported by
QuickFile server.
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SERVER_VERSION varchar Version value reported by QuickFile
server.

SEQ_NUM bigint A number used to uniquely identify
events generated at the same time.

SHORT_MSG varchar Message text associated with the
Message ID.

SOURCE_FILE varchar Source file name in a copy.

STATUS_CODE varchar Status code for the operation
performed.

SUBMITTER varchar User ID of the process submitter.

USER_DATA_1 varchar User metadata field 1.

USER_DATA_2 varchar User metadata field 2.

USER_DATA_3 varchar User metadata field 3.

USER_DATA_4 varchar User metadata field 4.

USER_EMAIL varchar User email address.

USER_FNAME varchar User full name.

USER_ID varchar User ID.

USER_REG varchar User registered. Value, when set, will
be "true" or "false".

UTC_OFFSET bigint The delta, in seconds, from Universal
Coordinated time for the recorded
LOG_DATE_TIME value.

FILE_SIZE bigint Size of file. Value set to -1 when
event has no value for this field.

MQ MFT Statistics Table (MQ_STATS_LOG)
The following table describes the data fields available from the MQ MFT statistics
table (MQ_STATS_LOG) for Sterling Control Center reports:

Element Type Description

ACTION varchar MQ FTE action type. The values are
started, progress, or completed.

ACTION_TIME varchar Action time. The format is
yyyy-mm-ssThh:mm:ss.nnnZ.

AGENTROLE varchar Agent role, for example, sourceAgent
or destinationAgent.

CALL_CMD_ARGUMENT varchar The call command arguments.

CALL_CMD_NAME varchar The call command name.

CALL_CMD_RETRYCOUNT varchar The call retry count.

CALL_CMD_RETRYWAIT varchar The call retry wait time.

CALL_CMD_SUCCESSRC varchar The call specification of a successful
RC.

CALL_CMD_TYPE varchar The call command type.

CALL_CRSLT_OC varchar The outcome of the call.

CALL_CRSLT_RETRIES varchar The number of retries for the call.
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CALL_CRSLT_RSLT_ERROR varchar The call resulting error.

CALL_CRSLT_RSLT_OC varchar The call resulting outcome.

CALL_CRSLT_RSLT_RC bigint The call resulting return code.

CALL_CRSLT_RSLT_STDERR varchar The call stderr output.

CALL_CRSLT_RSLT_STDOUT varchar The call stdout output.

CALL_CRSLT_RSLT_TIME varchar The call result time.

DESTAGENT_AGENT varchar Name of the destination agent.

DESTAGENT_QMGR varchar Name of the destination agent queue
manager.

DESTAGENT_SYSTEMINFO_ARCH varchar Architecture of the destination agent.

DESTAGENT_SYSTEMINFO_NAME varchar Name of the destination agent
operating system.

DESTAGENT_SYSTEMINFO_VER varchar Version of the destination agent
operating system.

EVENT_ID bigint ID number assigned by the system to
each event.

ID varchar MQ MFT identifier for the file
transfer.

JOB_NAME varchar Job name (if provided). Otherwise,
the value isMQ MFT_transfer.

LOG_DATE_TIME varchar Date and time the statistics record
was generated. The format is
yyyymmdd hh:mm:ss.nnn.

METADATA varchar User metadata. Format is
[key1=value1].[key2=value2]...

ORIGINATOR_HOSTNAME varchar Hostname of the request originator.

ORIGINATOR_MQMDUSERID varchar MQMD userid of the originator.

ORIGINATOR_USERID varchar Originator userid.

PART_KEY date Date the statistics record was
generated. The format is
yyyy-mm-dd

SRCAGENT_AGENT varchar Name of the source agent.

SRCAGENT_QMGR varchar Name of the source agent queue
manager.

SRCAGENT_SYSTEMINFO_ARCH varchar Architecture of the source agent.

SRCAGENT_SYSTEMINFO_NAME varchar Name of the source agent operating
system.

SRCAGENT_SYSTEMINFO_VER varchar Version of the source agent operating
system.

STATISTICS_ACTUALSTARTTIME varchar Action start time for the statistics.

STATISTICS_NUMFILEFAILURES bigint Number of file failures.

STATISTICS_NUMFILEWARNINGS bigint Number of file warnings.

STATISTICS_RETRYCOUNT bigint Number of retires.

STATUS_RESULTCODE varchar Result code.

STATUS_SUPPLEMENT varchar Supplement message.
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TS_INDEX bigint Transfer set index.

TS_ITEM_DEST_CS varchar Destination file checksum.

TS_ITEM_DEST_CS_METH varchar Destination file checksum method.

TS_ITEM_DEST_EXIST varchar The exists= specification.

TS_ITEM_DEST_FILE varchar Destination filename.

TS_ITEM_DEST_LMOD varchar Last modified date/time of the
destination file. The format is
yyyy-mm-ssThh:mm:ss.nnnZ.

TS_ITEM_DEST_Q_GROUPID varchar Destination queue group ID.

TS_ITEM_DEST_Q_MSGCOUNT bigint Count of messages to queue.

TS_ITEM_DEST_Q_MSGID varchar Destination queue message ID.

TS_ITEM_DEST_Q_MSGLENGTH bigint Length of message.

TS_ITEM_DEST_SIZE bigint Destination file size.

TS_ITEM_MODE varchar File mode, for example, binary.

TS_ITEM_SRC_CS varchar Source file checksum.

TS_ITEM_SRC_CS_METH varchar Source file checksum method.

TS_ITEM_SRC_DISP varchar Source file disposition.

TS_ITEM_SRC_FILE varchar Source filename.

TS_ITEM_SRC_LMOD varchar Last modified date and time of the
source file. The format is
yyyy-mm-ssThh:mm:ss.nnnZ.

TS_ITEM_SRC_Q_GROUPID varchar Source queue group id.

TS_ITEM_SRC_Q_MSGCOUNT bigint Count of messages to queue.

TS_ITEM_SRC_Q_MSGID varchar Source queue message id.

TS_ITEM_SRC_Q_MSGLENGTH bigint Length of message.

TS_ITEM_SRC_SIZE bigint Source file size.

TS_ITEM_STATUS_RSLTCODE varchar Result code for the transfer.

TS_ITEM_STATUS_SUPPLEMENT varchar The supplement message for the
transfer.

TS_ITEM_STATUS_SUPPLEMENT_ID varchar The supplement message id for the
transfer.

TS_SIZE bigint Size of the transfer set.

TS_STARTTIME varchar Start date and time of the transfer.
The format is yyyy-mm-
ssThh:mm:ss.nnnZ.

TS_TIME varchar The time of the transfer.

TS_TOTAL bigint Total number of files transferred in
this request.

VER varchar Transaction version.
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MQ MFT virtual statistics table (V_MQ_STATS_LOG)
The following table describes the data fields available from the MQ MFT Virtual
Statistics (V_MQ_STATS_LOG) table for Sterling Control Center reports:

Element Type Description

ACTION varchar MQ FTE action type. The values are
started, progress, or completed.

ACTION_TIME varchar Action time. The format is
yyyy-mm-ssThh:mm:ss.nnnZ.

AGENTROLE varchar Agent role, for example, sourceAgent
or destinationAgent.

CALL_CMD_ARGUMENT varchar The call command arguments.

CALL_CMD_NAME varchar The call command name.

CALL_CMD_RETRYCOUNT varchar The call retry count.

CALL_CMD_RETRYWAIT varchar The call retry wait time.

CALL_CMD_SUCCESSRC varchar The call specification of a successful
RC.

CALL_CMD_TYPE varchar The call command type.

CALL_CRSLT_OC varchar The outcome of the call.

CALL_CRSLT_RETRIES varchar The number of retries for the call.

CALL_CRSLT_RSLT_ERROR varchar The call resulting error.

CALL_CRSLT_RSLT_OC varchar The call resulting outcome.

CALL_CRSLT_RSLT_RC bigint The call resulting return code.

CALL_CRSLT_RSLT_STDERR varchar The call stderr output.

CALL_CRSLT_RSLT_STDOUT varchar The call stdout output.

CALL_CRSLT_RSLT_TIME varchar The call result time.

DEST_FILE varchar Destination file name in a copy
operation.

DESTAGENT_AGENT varchar Name of the destination agent.

DESTAGENT_QMGR varchar Name of the destination agent queue
manager.

DESTAGENT_SYSTEMINFO_ARCH varchar Architecture of the destination agent.

DESTAGENT_SYSTEMINFO_NAME varchar Name of the destination agent
operating system.

DESTAGENT_SYSTEMINFO_VER varchar Version of the destination agent
operating system.

EVENT_ID bigint ID number assigned by the system to
each event.

EVENT_TYPE bigint Code indicating the type of event.

FILE_SIZE bigint Size of the file transferred by the
Sterling Connect:Direct Process or
Sterling Connect:Enterprise batch.

FROM_NODE varchar Server that sent the file.

P=Pnode was sending server.

S=Snode was sending server.
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ID varchar MQ MFT identifier for the file
transfer.

JOB_NAME varchar Job name (if provided). Otherwise,
the value isMQ MFT_transfer.

LOG_DATE_TIME varchar Date and time the statistics record
was generated. The format is
yyyymmdd hh:mm:ss.nnn.

METADATA varchar User metadata. Format is
[key1=value1].[key2=value2]...

MSG_ID varchar Server or Sterling Control Center
message ID issued with the event.

NODE_ID varchar Server name of alias.

NODE_TYPE varchar Code indicating the type of server.
The server types are:

0=Sterling Control Center

1=Sterling Connect:Direct

2=Sterling Connect:Enterprise

3=Sterling B2B Integrator

4=FTP Server

5=Sterling Connect:Express

6=QuickFile

7=MQ MFT

ORIG_NODE varchar The server that initiated the Process.

ORIGINATOR_HOSTNAME varchar Hostname of the request originator.

ORIGINATOR_MQMDUSERID varchar MQMD userid of the originator.

ORIGINATOR_USERID varchar Originator userid.

PROC_ID varchar Sterling Connect:Direct Process or
Sterling Connect:Enterprise batch
number.

PROC_NAME varchar Sterling Connect:Direct Process name
or Sterling Connect:Enterprise batch
name.

REMOTE_NODE varchar Name of the remote server involved
in the Process or file transfer.

RET_CODE varchar Specifies a numeric code returned
from a completed Process or file
transfer that indicates failure or
success. The standard return codes
are:

0=Successful completion

4=Warning

8=Error

16=Catastrophic error
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SEQ_NUM bigint A number used to uniquely identify
events generated at the same time.

SHORT_MSG varchar Message text associated with the
Message ID.

SOURCE_FILE varchar Source file name in a copy.

SRCAGENT_AGENT varchar Name of the source agent.

SRCAGENT_QMGR varchar Name of the source agent queue
manager.

SRCAGENT_SYSTEMINFO_ARCH varchar Architecture of the source agent.

SRCAGENT_SYSTEMINFO_NAME varchar Name of the source agent operating
system.

SRCAGENT_SYSTEMINFO_VER varchar Version of the source agent operating
system.

STATISTICS_ACTUALSTARTTIME varchar Action start time for the statistics.

STATISTICS_NUMFILEFAILURES bigint Number of file failures.

STATISTICS_NUMFILEWARNINGS bigint Number of file warnings.

STATISTICS_RETRYCOUNT bigint Number of retires.

STATUS_RESULTCODE varchar Result code.

STATUS_SUPPLEMENT varchar Supplement message.

STEP_NAME varchar Name of the Sterling Connect:Direct
Process step.

SUBMITTER varchar User ID of the Process submitter.

TS_INDEX bigint Transfer set index.

TS_ITEM_DEST_CS varchar Destination file checksum.

TS_ITEM_DEST_CS_METH varchar Destination file checksum method.

TS_ITEM_DEST_EXIST varchar The exists= specification.

TS_ITEM_DEST_FILE varchar Destination filename.

TS_ITEM_DEST_LMOD varchar Last modified date/time of the
destination file. The format is
yyyy-mm-ssThh:mm:ss.nnnZ.

TS_ITEM_DEST_Q_GROUPID varchar Destination queue group ID.

TS_ITEM_DEST_Q_MSGCOUNT bigint Count of messages to queue.

TS_ITEM_DEST_Q_MSGID varchar Destination queue message ID.

TS_ITEM_DEST_Q_MSGLENGTH bigint Length of message.

TS_ITEM_DEST_SIZE bigint Destination file size.

TS_ITEM_MODE varchar File mode, for example, binary.

TS_ITEM_SRC_CS varchar Source file checksum.

TS_ITEM_SRC_CS_METH varchar Source file checksum method.

TS_ITEM_SRC_DISP varchar Source file disposition.

TS_ITEM_SRC_FILE varchar Source filename.

TS_ITEM_SRC_LMOD varchar Last modified date and time of the
source file. The format is
yyyy-mm-ssThh:mm:ss.nnnZ.

TS_ITEM_SRC_Q_GROUPID varchar Source queue group id.
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TS_ITEM_SRC_Q_MSGCOUNT bigint Count of messages to queue.

TS_ITEM_SRC_Q_MSGID varchar Source queue message id.

TS_ITEM_SRC_Q_MSGLENGTH bigint Length of message.

TS_ITEM_SRC_SIZE bigint Source file size.

TS_ITEM_STATUS_RSLTCODE varchar Result code for the transfer.

TS_ITEM_STATUS_SUPPLEMENT varchar The supplement message for the
transfer.

TS_ITEM_STATUS_SUPPLEMENT_ID varchar The supplement message id for the
transfer.

TS_SIZE bigint Size of the transfer set.

TS_STARTTIME varchar Start date and time of the transfer.
The format is yyyy-mm-
ssThh:mm:ss.nnnZ.

TS_TIME varchar The time of the transfer.

TS_TOTAL bigint Total number of files transferred in
this request.

USER_DATA_1 varchar User metadata field 1.

USER_DATA_2 varchar User metadata field 2.

USER_DATA_3 varchar User metadata field 3.

USER_DATA_4 varchar User metadata field 4.

VER varchar Transaction version.

Event type table (EVENT_TYPE)
The Event Type table contains a listing of Sterling Control Center event types and
descriptions.

Element Type Description

EVENT_TYPE bigint Code indicating the type of event.
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EVENT_TYPE_DESCR varchar Description of the event type codes. The codes and descriptions
are:

1=Process Step Started

2=Process Step Ended

3=Process Started

4=Process Ended

5=Server Status

6=SLC Notification

7=Server Shutdown Started (for future use)

8=Server Shutdown (for future use)

9=Process Status

10=Server license

11=Server Error

12=Server Command

13=Connection Started

14=Connection Shutdown Started (for future use)

15=Sterling Control Center Status (for future use)

16=Process Queue

17=Process Interrupted

66=Suppressed SLC Notification

Node type table (NODE_TYPE)
The Node Type table contains a listing of node (server) types monitored by
Sterling Control Center.

Element Type Description

NODE_TYPE bigint Code indicating the type of event.

Chapter 5. Data for third-party reporting tools 81



Element Type Description

NODE_TYPE_DESCR varchar Code indicating the type of server. The server types are:

0=Sterling Control Center

1=Sterling Connect:Direct

2=Sterling Connect:Enterprise

3=Sterling B2B Integrator

4=FTP Server

5=Sterling Connect:Express

6=QuickFile

7=MQ MFT

Node discovery pair connections table (PAIR_CONN)
The following table describes the data fields available from the Node Discovery
Pair Connections Table for Sterling Control Center reports.

Element Type Description

DISCOVERED_ID bigint Reference to Discovery Node table.

DISCOVERY_START_TM varchar Discovery start date range value.

DISCOVERY_STOP_TM varchar Discovery end date range value.

EXPLORER_ID bigint Reference to Discovery Node table.

FROM_NETMAP smallint 1=Found in Netmap

0=Not found in Netmap

FROM_STATS smallint 1=Found in statistics

0=Not found in statistics

LAST_CONN_D2E varchar Last connection time found from
Discovered to Explorer node.

LAST_CONN_E2D varchar Last connection time found from
Explorer to Discovered node.

TIMES_CONN_D2E bigint Number of connections initiated by
Discovered node to Explorer node.

TIMES_CONN_E2D bigint Number of connections initiated by
Explorer node to Discovered node.

Discovery node table (DISCOVERY_NODE)
The following table describes the data fields in the Discovery Node Table.

Element Type Description

ANOS400 smallint 0=Node is not i5/OS.

1=Node is i5/OS.

API_PORT varchar API port value.
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COMMENTS text User description for node.

CONNECTION_TIMEOUT bigint Internal field used for Node Discovery.

DB_LIBRARY varchar Sterling Connect:Direct for i5/OS™ database library name.

DISCOVERED_TIME varchar Time node was discovered.

DISCOVERY_START_TM varchar Discovery start date range value.

DISCOVERY_STOP_TM varchar Discovery end date range value.

DTF_ADDRESS varchar Server host address.

DTF_PORT varchar Server port value.

ENABLED smallint 0=Disabled

1=Enabled

FROM_NETMAP smallint 0=Not found in Netmap.

1=Found in Netmap.

FROM_STATS smallint 0=Not found in statistics.

1=Found in statistics.

HOST_NAME varchar Host name for server.

ID bigint For internal use.

IGNORED smallint For discovered nodes:

1=Found in Mylist.

0=Found in Discovered list.

LAST_DSCVRY_ATTEMPT varchar Time of last discovery attempt.

LST_SCCSSFL_DSCVRY varchar Time of last successful discovery attempt.

MESSAGE_KEY varchar Message.

MESSAGE_PARAMETERS text Values used to construct message text.

MESSAGE_PRIORITY bigint Priority of message

NET_MAP_ENTRIES bigint Number of Netmap entries found.

NODE_NAME varchar Name of server.

OPERATING_SYSTEM varchar Server operating system.

PARTNERS bigint Number of partner nodes found.

PASSWORD text Password for API connection.

PROCESSES bigint Number of Processes found to have run during Discovery.

PROTOCOL varchar Internal field for Node Discovery.

RETURN_CODE bigint Return code for Discovery.

SERVER_LICENSE text Server license text.

SERVICE_ID varchar Node or alias name.

SOURCE_PORT varchar Source port range to use for API connection.

SRVR_LCNS_EXPRTN_D varchar Server license expiration date.

TYPE varchar Type of node.

E=Explorer node

D=Discovered node
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USER_ID varchar User ID for API connection.

Metadata labels table (META_DATA_LABELS)
The following table describes the data fields available from the
META_DATA_LABELS database table for reports. It holds the user-provided labels
for the metadata fields.

There are four rows in this table, one for each of the four metadata fields.

Element Type Description

USER_DATA_TITLE varchar Name of the metadata field.

USER_DATA_FIELD varchar User-provided label for the metadata field. The default is User
Data x, where x ranges from one to four, or SERVER_DATA_x
where x ranges from one to ten.

Default table contents are as follows:

USER_DATA_TITLE USER_DATA_FIELD

userData1Title User Data 1

userData2Title User Data 2

userData3Title User Data 3

userData4Title User Data 4

serverMetaData1Title Server Data 1

serverMetaData2Title Server Data 2

serverMetaData3Title Server Data 3

serverMetaData4Title Server Data 4

serverMetaData5Title Server Data 5

serverMetaData6Title Server Data 6

serverMetaData7Title Server Data 7

serverMetaData8Title Server Data 8

serverMetaData9Title Server Data 9

serverMetaData10Title Server Data 10

Sterling Control Center internal tables
The following tables are used internally by Sterling Control Center. They are not
available for third-party reporting.
v DURATION_MONITORS (No longer used)
v TIME_MONITORS
v LICENSES
v CCC_INFO
v CONFIG_JOBS
v CONFIG_OBJECTS
v CONFIG_SERVER_IDS
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v CONFIG_VERSIONS
v AUDIT_LOG
v FILE_COUNTS
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Notices

This information was developed for products and services offered in the U.S.A.

IBM may not offer the products, services, or features discussed in this document in
other countries. Consult your local IBM representative for information on the
products and services currently available in your area. Any reference to an IBM
product, program, or service is not intended to state or imply that only that IBM
product, program, or service may be used. Any functionally equivalent product,
program, or service that does not infringe any IBM intellectual property right may
be used instead. However, it is the user's responsibility to evaluate and verify the
operation of any non-IBM product, program, or service.

IBM may have patents or pending patent applications covering subject matter
described in this document. The furnishing of this document does not grant you
any license to these patents. You can send license inquiries, in writing, to:

IBM Director of Licensing

IBM Corporation

North Castle Drive

Armonk, NY 10504-1785

U.S.A.

For license inquiries regarding double-byte character set (DBCS) information,
contact the IBM Intellectual Property Department in your country or send
inquiries, in writing, to:

Intellectual Property Licensing

Legal and Intellectual Property Law

IBM Japan Ltd.

19-21, Nihonbashi-Hakozakicho, Chuo-ku

Tokyo 103-8510, Japan

The following paragraph does not apply to the United Kingdom or any other
country where such provisions are inconsistent with local law:
INTERNATIONAL BUSINESS MACHINES CORPORATION PROVIDES THIS
PUBLICATION "AS IS" WITHOUT WARRANTY OF ANY KIND, EITHER
EXPRESS OR IMPLIED, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED
WARRANTIES OF NON-INFRINGEMENT, MERCHANTABILITY OR FITNESS
FOR A PARTICULAR PURPOSE. Some states do not allow disclaimer of express or
implied warranties in certain transactions, therefore, this statement may not apply
to you.

This information could include technical inaccuracies or typographical errors.
Changes are periodically made to the information herein; these changes will be
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incorporated in new editions of the publication. IBM may make improvements
and/or changes in the product(s) and/or the program(s) described in this
publication at any time without notice.

Any references in this information to non-IBM Web sites are provided for
convenience only and do not in any manner serve as an endorsement of those Web
sites. The materials at those Web sites are not part of the materials for this IBM
product and use of those Web sites is at your own risk.

IBM may use or distribute any of the information you supply in any way it
believes appropriate without incurring any obligation to you.

Licensees of this program who wish to have information about it for the purpose
of enabling: (i) the exchange of information between independently created
programs and other programs (including this one) and (ii) the mutual use of the
information which has been exchanged, should contact:

IBM Corporation

J46A/G4

555 Bailey Avenue

San Jose, CA 95141-1003

U.S.A.

Such information may be available, subject to appropriate terms and conditions,
including in some cases, payment of a fee.

The licensed program described in this document and all licensed material
available for it are provided by IBM under terms of the IBM Customer Agreement,
IBM International Program License Agreement or any equivalent agreement
between us.

Any performance data contained herein was determined in a controlled
environment. Therefore, the results obtained in other operating environments may
vary significantly. Some measurements may have been made on development-level
systems and there is no guarantee that these measurements will be the same on
generally available systems. Furthermore, some measurements may have been
estimated through extrapolation. Actual results may vary. Users of this document
should verify the applicable data for their specific environment.

Information concerning non-IBM products was obtained from the suppliers of
those products, their published announcements or other publicly available sources.
IBM has not tested those products and cannot confirm the accuracy of
performance, compatibility or any other claims related to non-IBM products.
Questions on the capabilities of non-IBM products should be addressed to the
suppliers of those products.

All statements regarding IBM's future direction or intent are subject to change or
withdrawal without notice, and represent goals and objectives only.

All IBM prices shown are IBM's suggested retail prices, are current and are subject
to change without notice. Dealer prices may vary.
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This information is for planning purposes only. The information herein is subject to
change before the products described become available.

This information contains examples of data and reports used in daily business
operations. To illustrate them as completely as possible, the examples include the
names of individuals, companies, brands, and products. All of these names are
fictitious and any similarity to the names and addresses used by an actual business
enterprise is entirely coincidental.

COPYRIGHT LICENSE:

This information contains sample application programs in source language, which
illustrate programming techniques on various operating platforms. You may copy,
modify, and distribute these sample programs in any form without payment to
IBM, for the purposes of developing, using, marketing or distributing application
programs conforming to the application programming interface for the operating
platform for which the sample programs are written. These examples have not
been thoroughly tested under all conditions. IBM, therefore, cannot guarantee or
imply reliability, serviceability, or function of these programs. The sample
programs are provided "AS IS", without warranty of any kind. IBM shall not be
liable for any damages arising out of your use of the sample programs.

Each copy or any portion of these sample programs or any derivative work, must
include a copyright notice as follows:

© IBM 2013. Portions of this code are derived from IBM Corp. Sample Programs. ©
Copyright IBM Corp. 2013.

If you are viewing this information softcopy, the photographs and color
illustrations may not appear.

Trademarks

IBM, the IBM logo, and ibm.com® are trademarks or registered trademarks of
International Business Machines Corp., registered in many jurisdictions worldwide.
Other product and service names might be trademarks of IBM or other companies.
A current list of IBM trademarks is available on the Web at “Copyright and
trademark information” at http://www.ibm.com/legal/copytrade.shtml.

Adobe, the Adobe logo, PostScript, and the PostScript logo are either registered
trademarks or trademarks of Adobe Systems Incorporated in the United States,
and/or other countries.

IT Infrastructure Library is a registered trademark of the Central Computer and
Telecommunications Agency which is now part of the Office of Government
Commerce.

Intel, Intel logo, Intel Inside, Intel Inside logo, Intel Centrino, Intel Centrino logo,
Celeron, Intel Xeon, Intel SpeedStep, Itanium, and Pentium are trademarks or
registered trademarks of Intel Corporation or its subsidiaries in the United States
and other countries.

Linux is a registered trademark of Linus Torvalds in the United States, other
countries, or both.
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Microsoft, Windows, Windows NT, and the Windows logo are trademarks of
Microsoft Corporation in the United States, other countries, or both.

ITIL is a registered trademark, and a registered community trademark of the Office
of Government Commerce, and is registered in the U.S. Patent and Trademark
Office.

UNIX is a registered trademark of The Open Group in the United States and other
countries.

Java™ and all Java-based trademarks and logos are trademarks or registered
trademarks of Oracle and/or its affiliates.

Cell Broadband Engine is a trademark of Sony Computer Entertainment, Inc. in the
United States, other countries, or both and is used under license therefrom.

Linear Tape-Open, LTO, the LTO Logo, Ultrium and the Ultrium Logo are
trademarks of HP, IBM Corp. and Quantum in the U.S. and other countries.

Connect Control Center®, Connect:Direct®, Connect:Enterprise, Gentran®,
Gentran®:Basic®, Gentran:Control®, Gentran:Director®, Gentran:Plus®,
Gentran:Realtime®, Gentran:Server®, Gentran:Viewpoint®, Sterling Commerce™,
Sterling Information Broker®, and Sterling Integrator® are trademarks or registered
trademarks of Sterling Commerce®, Inc., an IBM Company.

Other company, product, and service names may be trademarks or service marks
of others.
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